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Introduction

Welcome to the O2™ workstation. The O2 Workstation Owner’s Guide is your guide to
installing, troubleshooting, and repairing your workstation. Specifically, it tells you how
to
•

set up the workstation, including an overview of the hardware (Chapter 1, “Getting
Started”).

•

memory and option boards (Chapter 2, “Installing or Removing Memory and
Option Boards”)

•

install and remove internal and external peripheral devices (Chapter 3, “Installing
or Removing Peripherals: Internal and External Devices”)

•

diagnose hardware problems (Chapter 4, “Troubleshooting”).

•

order and replace faulty parts (Chapter 5, “Ordering, Removing, and Installing
Replacement Parts”).

•

create a safe and comfortable environment for your workstation and maintain the
system correctly (Chapter 6, “Safety and Regulatory Information”).

•

find technical specifications (Appendix A, “Technical Specifications.”).

xv

Chapter 1

1. Getting Started

Welcome to the O2 workstation.
This chapter contains an overview of the exterior of the workstation and tells you how to
connect the parts of your workstation. The following topics are covered:
•

“Overview and Getting Started”

•

“Checking Your Shipment”

•

“Out of Box Experience”

•

“Other Sources of Information”

•

“Turning the Workstation On or Off”

•

“Setting Up the O2Cam Digital Video Camera”

•

“Securing the O2 Workstation”

•

“Locating Your Workstation’s Serial Number”

Overview and Getting Started
Take a minute to familiarize yourself with your workstation. Note that some models do
not have video connectors on the side or rear panel.
To see an overview of the workstation, technical specifications, ergonomic information
in a web browser, click Hardware Central. Or, if you’re viewing this on a remote server,
see Appendix A, “Technical Specifications.”)
The following are inline images:
•

Figure 1-1 shows the controls on the front of the workstation

•

Figure 1-2 shows the rear view of the R5000 workstation

•

Figure 1-3 shows the rear view of the R10000 workstation
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•

Figure 1-4 shows the audio and video ports on the side panel
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Front View of the O2 Workstation
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Rear View of the O2 R5000 Workstation
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Rear View of the O2 R10000 Workstation
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Checking Your Shipment
1.

Check that you received all the parts shown in Figure 1-5.

Note: Not all models include the O2Cam.
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Figure 1-5
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Set up steps

Setting Up the O2 Workstation

Setting Up the O2 Workstation
Follow these steps to set up your workstation. The setup card that comes with the
workstation also contains this information.
1.

Connect the keyboard and the mouse to the workstation (Figure 1-6).

Grap
Silic

Figure 1-6

hics

on

Connecting the Keyboard and Mouse to the Workstation

2. Connect the Ethernet 10-BASE T or 100-BASE T network cable to the Ethernet RJ45
connector on the rear of the workstation (Figure 1-7). If you do not have an Ethernet
connection in your office, check with your system administrator.
The O2 workstation supports Ethernet 10-BASE T and 100-BASE T. For optional
networking PCI solutions supported on your workstation, see your Silicon
Graphics service provider.
3. If you received the O2Cam, connect it to the workstation (Figure 1-7).
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Figure 1-7

Connecting the Network Cable and the Camera to the Workstation

4. Connect the monitor cable to the workstation and to the monitor (Figure 1-8).
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Figure 1-8

Connecting the Monitor to the Workstation

5. Connect the power cables as follows (Figure 1-9).
•

Connect one power cable to the monitor and to a working wall outlet.

•

Connect the other power cable to the workstation and to a working wall outlet.

CAUTION
Always disconnect
the power cable
before removing
the system module.
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G

(HD

1
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2 (B
HD
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Figure 1-9

Connecting the Power Cables to the Monitor and to the Workstation
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6. Turn on the monitor and the workstation (Figure 1-10).

Silic

onG

raph

ics

1
2

Figure 1-10
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Turning On the Monitor and the Workstation

Out of Box Experience

Out of Box Experience
The Out of Box Experience CD provides an exciting 3D environment to guide you
through the process of getting up and running on your workstation.
•

It helps you configure your network, language, time zone, and user account.

•

The interactive System Tour guides you through your workstation’s desktop
environment.

•

The Innovations Gallery demonstrates how other customers use our workstations to
apply the latest technologies.

•

Jungle Island provides some fun and games.

If your workstation does not have a CD-ROM drive, or if you prefer to set up your system
without using the Out of Box Experience, you can access the system administration tools
by clicking the EZsetup icon at the login screen.

Installation CD

Start Here

Figure 1-11

The Out of Box Experience
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Other Sources of Information
The printed Owner’s Guide contains all the information you need when your workstation
is turned off and you can’t access online documentation. Additional information such as
a hardware overview with 3D animation, technical specifications, cable pinout
assignments, and regulatory statements is in this manual, the O2 Hardware Reference
Guide.

12
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IRIS InSight Document Library
Online books are located in the IRIS InSight Document Library. From the Toolchest
choose Help > Online Books.

“How do I” and “InfoSearch”
From the Toolchest choose Help > How do I or Help > InfoSearch. “How Do I” tells you
which application you need to accomplish a task, and also lets you launch the application
from the help card. “InfoSearch” lets you search or browse through all online information
on your desktop.

Technical Publications Library
If you have access to the Internet, you can view most manuals on the Technical
Publications Library on the Silicon Graphics homepage at
http://www.sgi.com/Technology/TechPubs/

System Tour
The interactive System Tour guides you through your workstation’s desktop
environment. It is on the Out of Box Experience CD that comes with the workstation. You
can also reach it by clicking its icon on the desktop.

Turning the Workstation On or Off
To turn your workstation on or off, press the power button on the front (Figure 1-12). It’s
not necessary to shut down the system software before turning it off.
You can also turn the workstation off from the Toolchest Menu on the desktop. See
“Turning the Workstation Off From the Toolchest Menu.”
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Silic

Figure 1-12
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Turning the Workstation On or Off

Turning the Workstation Off From the Toolchest Menu
From the Toolchest, choose System > System Shutdown. If you have a root password set,
you are prompted to enter it.
As the system shuts down, you see the following:

14

•

A cautionary message warning you that all running applications are stopped and
remote users are logged off. Click OK to shut down the system.

•

A notifier that the system is shutting down.

•

A message telling you it is okay to power off. When you see this notifier, you can
press and release the power button on the front of the workstation. Or, to shut down
and restart the system without powering off, click Restart.

Setting Up the O2Cam Digital Video Camera

Setting Up the O2Cam Digital Video Camera
Note: The O2Cam is not a standard item with all O2 workstations.

The O2Cam color digital video camera captures images and video recordings. It has a
built-in microphone that points in the same direction as the lens. You speak toward the
front of the camera.
Note: If you wish to place the camera face down for snapshots of documents or objects

on the desktop, a desktop camera stand is available. To order one, contact your local
Silicon Graphics service provider.
•

Figure 1-13 shows how to connect the O2Cam to the workstation. Connect the
camera before turning on workstation so that the system recognizes the device.

•

Figure 1-14 show the features of the O2Cam.

•

Figure 1-15 shows how to use the microphone on the camera.

•

Figure 1-16 shows how to set up the O2Cam on your monitor.

•

Figure 1-17 shows how to set up the O2Cam on the Presenter 1280 flat panel display.

For information on software media tools that you can use with the camera, see “About
The Digital Media Tools Guide.”
For the camera’s technical specifications, see Hardware Central. (If your web browser is
not loaded, it takes a few seconds to load.) Or, if you’re viewing this on a remote server,
see “O2 Camera Technical Specifications.”
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Connecting the O2Cam to the Workstation

Figure 1-13

Lens cover
Record button

Focus ring

Tilt
hinge

LED activity
indicator

Figure 1-14
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Directional
microphone

Front View of the O2Cam

Setting Up the O2Cam Digital Video Camera

.

Figure 1-15

Using the O2Cam’s Built In Microphone

Figure 1-16

Setting Up the O2Cam on Your Monitor
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Figure 1-17

Setting Up the Camera on Presenter 1280

Securing the O2 Workstation
Your workstation comes with a separate lockbar and a built-in slot for the Kensington™
lock and cable. You purchase the lock and cable separately from Silicon Graphics. To
secure the workstation, follow these steps:
To secure the workstation, follow these steps:
1.

Place the lockbar on the rear of the workstation, as shown in Figure 1-18.

2. Insert the Kensington lock through the lockbar into the built-in security slot on the
workstation.
3. Insert the key into the lock and turn it.

18
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Figure 1-18

Attaching the Lockbar to the Workstation

Figure 1-19

Locking the O2 Workstation
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Locating Your Workstation’s Serial Number
From time to time you may need to know your workstation’s serial number. There are
several ways you can find it. The serial number is the one beginning with the numbers 08.
Note: The illustrations show an R5000 workstation. The serial number is in the same

locations on an R10000 workstation.
•

On the rear of the workstation, it is located on the bottom right beneath the audio
visual module (Figure 1-20).

•

Inside the workstation, it’s on the connector of the PCI tray, which is attached to the
system module (Figure 1-21). (To remove the system module, see “Removing the
System Module.”)
Caution: The small, printed circuit board beneath the PCI tray contains a host chip
with important system information such as the serial number. Do not mix PCI trays
between workstations. To check if your workstation has its original PCI tray,
compare the serial number on the rear of the workstation with the serial number on
the PCI tray connector. The serial numbers should be the same.

•

If your system is running, from a shell window, type:
netstat -ia

•

20

From the Toolchest choose System > System Manager > About This System.

Locating Your Workstation’s Serial Number

Figure 1-20

Locating the Serial Number On the Rear

Figure 1-21

Locating the Serial Number Inside the Workstation
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Chapter 2

2. Installing or Removing Memory and Option Boards

This chapter explains how to install or remove DIMMs (double in-line memory
modules), PCI option boards, or the flat panel/stereo view option board. The following
topics are covered:
•

“Removing the System Module”

•

“Installing Memory Modules”

•

“Removing Memory Modules”

•

“Installing a PCI Board: R5000 Workstation”

•

“Removing a PCI Board: R5000 Workstation”

•

“Installing a PCI Board: R10000 Workstation”

•

“Removing a PCI Board: R10000 Workstation”

•

“Installing a Digital Display Adapter Board”

•

“Removing a Digital Display Adapter Board”

•

“Reinstalling the System Module”

•

“Verifying the Hardware Installation”

Caution: Boards and DIMMs are extremely sensitive to static electricity. Handle the
boards carefully, and wear the wrist strap while installing the hardware.

Removing the System Module
Before installing memory or option boards, you must turn off the workstation, remove
the power cable, and remove the system module from the chassis.
Note: The illustrations show an O2 R5000 workstation. Installing and removing the

system module is the same for the O2 R10000 workstation.
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1.

Turn off the workstation by pressing the power button on the front (Figure 2-1).
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Figure 2-1
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Turning Off the O2 Workstation

2. Remove the power cable from the rear. (Figure 2-2).
Caution: Always remove the power cable before removing the system module from
the workstation.
When you walk quickly across a room, or sit down or stand up, you build up a lot of
static electricity. To perform any of the hardware tasks on the system module, it’s a
good idea to stand in one place until you’ve completed the task.
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Figure 2-2

Disconnecting the Power Cables

3. The system module is on the left as you face the rear. Pull down the lever on the left
side of the module to release it (Figure 2-3).
Note: There is no need to remove the cables from the system module, as long as you

are careful when handling it.
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Figure 2-3

Pulling Down the Lever on the System Module

4. Slide the system module out of the chassis (Figure 2-4).
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Figure 2-4

Remove the System Module From the Chassis

5. Lay the system module on a clean, flat surface, such as your desktop (Figure 2-5).

Figure 2-5

Laying the System Module on a Flat Surface
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•

To install memory, go to “Installing Memory Modules.”

•

To install a PCI option board on an R5000 workstation, go to

•

To remove a PCI option board on an R5000 workstation, go to “Removing the PCI
Tray: R5000 Workstation.”

•

To install a PCI option board on an R10000 workstation, go to “Installing a PCI
Board: R10000 Workstation.”

•

To remove a PCI option board on an R10000 workstation, go to “Removing the PCI
Tray: R10000 Workstation.”

•

To install a digital display adapter board (such as the Presenter 1280 adapter), go to
“Installing a Digital Display Adapter Board.”

•

To remove a digital display adapter board, go to “Removing a Digital Display
Adapter Board.”

Installing Memory Modules
To see a 3D animation of installing memory modules, click Hardware Central. When the
browser window opens, click “Hardware Overview” and then “Installing Memory
Modules.” (If your web browser is not loaded, it takes a few seconds to load.) If you are
viewing this on a remote server, the 3D animation is not available.
Note: The illustrations show an O2 R5000 workstation. Installing and removing memory

modules is the same for the O2 R10000 workstation.
Caution: The O2 workstation uses DIMMs (Double Inline Memory Modules). DIMMs
are extremely sensitive to static electricity. Handle the modules carefully, and wear the
wrist strap while installing them.
1.

If you have not already done so, remove the power cable, and remove the system
module from the chassis. See “Removing the System Module.”

2. Components on the system module are extremely sensitive to static electricity.
Before touching any of the components, ground yourself to a metal part of the
chassis. Attach the wrist strap to your wrist and to the PCI tray (Figure 2-6).
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Figure 2-6

Attaching the Wrist Strap

3. Familiarize yourself with the memory (DIMM) banks (Figure 2-7) and (Figure 2-8).
There are eight sockets, numbered 1 through 8. Two sockets form a bank.
The minimum configuration has 32 MB of memory—one 16 MB module installed in
slot 1 and one 16 MB module installed in slot 2.
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DIMM banks

Banks

Figure 2-7

Locating the DIMM Banks

8
7
6
5
4
3
2
1

Figure 2-8

Top Down View of the DIMM Banks

4. Read the following guidelines and then go to the next step.
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•

Sockets 1 and 2 must always be populated.

•

Install the DIMMs in groups of two.

Installing Memory Modules

•

A bank of two slots must have a DIMM in each slot or be empty (except for slots
1 and 2 which must always be populated).

•

A bank of two slots must have the same capacity DIMM installed in each slot.
You cannot mix capacities in one bank.
For example, you can install a 16 MB module in slot 3, a 16 MB module in slot 4,
a 32 MB module in slot 5 and a 32 MB module in slot 6.
But you cannot install a 16 MB module in slot 3 and a 32 MB module in slot 4.

Note: If you need to remove a DIMM, see “Removing Memory Modules.”

5. Install the DIMMs consecutively in group of two, beginning with the lowest open
slot (Figure 2-9).
•

Hold the DIMM over the socket without tilting it.

•

Lower the DIMM, pushing it straight down into the socket gently but firmly.
You hear a click as it is seated and the latches on each side of the module snap
up.

Figure 2-9

Installing the Memory Modules

6. Check the DIMMs visually to make sure they are installed correctly (Figure 2-10).
•

The tops of the DIMMs of the same capacity should be even.
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•

The DIMMs should all be absolutely vertical (no leaning).

•

The latches on the sides should be fitting snugly against the DIMM.

Figure 2-10

Checking the DIMM Installation

7. Remove the wrist strap and go to “Reinstalling the System Module.”

Removing Memory Modules
1.

If you have not already done so, remove the power cable, and remove the system
module from the chassis. See “Removing the System Module.”

2. Before touching any of the components, ground yourself to a metal part of the
chassis. Attach the wrist strap to your wrist and to the PCI tray (Figure 2-11).
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Figure 2-11

Attaching the Wrist Strap

3. Remove the DIMM by pushing down the latches on both sides to release it. Pick up
the DIMM and set it aside (Figure 2-12).

Figure 2-12

Removing the Memory Module

4. To install memory modules, see “Installing Memory Modules.”
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5. Or, remove the wrist strap and go to “Reinstalling the System Module.”

Installing a PCI Board: R5000 Workstation
Note: Check the documentation that comes with the PCI board for instructions on

installing the software. The software may include online software guides.
1.

If you have not already done so, remove the power cable, and remove the system
module from the chassis. (See “Removing the System Module.”)
Caution: The small, printed circuit board beneath the PCI tray contains a host chip
with important system information such as the serial number. Do not mix PCI trays
between workstations. If you remove the PCI tray, always replace it, or the
workstation will not operate correctly.

2. Release the PCI tray by pushing up the lever on the side (Figure 2-13). The tray pops
up.

Figure 2-13

Releasing the PCI Tray

3. Push down slightly on the rear of the PCI tray and remove it from the system
module (Figure 2-14).
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Figure 2-14

Removing the PCI Tray

4. Hold the PCI tray with one hand and remove the screw and the filler panel from the
tray (Figure 2-15). Keep the panel and screw. If you later remove the PCI board and
do not replace it, you must reinstall the filler panel.
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Figure 2-15

Removing the Screw and Filler Panel

5. Slide the PCI board into the tray and push the PCI connector firmly into the slot
(Figure 2-16). Make sure it is completely seated.
6. Replace the screw and tighten it (Figure 2-16).
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Figure 2-16

Installing the PCI Board

7. Replace the tray in the system module (Figure 2-17).
•

Engage the hinge on the PCI tray in the slot on the system module.

•

Lower the tray and insert the connector into the slot, pushing toward the back
of the system module as you do this.
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Figure 2-17

Replacing the PCI Tray in the System Module

8. Push the tray down firmly until it is completely seated. Check that the lever returns
to its starting position (Figure 2-18).
Caution: If the PCI tray is not completely seated, the system module will not slide
back into the chassis.
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Figure 2-18

PCI Tray Seated Correctly

Note: If the option board you installed comes with a cable, remember to connect the

cable to the option board’s external port, after reinstalling the system module.
9. Go to “Reinstalling the System Module.”

Removing a PCI Board: R5000 Workstation
1.

If you have not already done so, remove the power cable and remove the system
module from the chassis. (See “Removing the System Module.”)

2. Release the PCI tray by pushing up the lever on the side (Figure 2-19). The tray pops
up.
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Figure 2-19

Releasing the PCI Tray

3. Push down slightly on the rear of the PCI tray and remove it from the system
module (Figure 2-20).

Figure 2-20

Removing the PCI Tray

4. Remove the screw that secures the board (Figure 2-21). Slide the PCI board out of
the tray. It may be a little difficult to remove.
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Figure 2-21

Removing the Screw and the PCI Board

5. If you are installing another PCI board, see “Installing a PCI Board: R5000
Workstation” on page 34. Otherwise, replace the filler panel and screw
(Figure 2-22). (You removed the panel and screw when you installed the board.)
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Figure 2-22

Replacing the Filler Panel and Screw on the PCI Tray

6. Go to “Reinstalling the System Module.”

Installing a PCI Board: R10000 Workstation
Note: Check the documentation that comes with the PCI board for instructions on

installing the software. The software may include online software guides.
1.

If you have not already done so, remove the power cable, and remove the system
module from the chassis. (See “Removing the System Module.”)
Caution: The small, printed circuit board beneath the PCI tray contains a host chip
with important system information such as the serial number. Do not mix PCI trays
between workstations. If you remove the PCI tray, always replace it, or the
workstation will not operate correctly.

2. Remove the screw and filler panel from the PCI tray.
Keep the panel. If you later remove the PCI board and do not replace it, you must
reinstall the filler panel and screw (Figure 2-23).
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Figure 2-23

Removing the Screw and Filler Panel

3. Install the PCI board as follows:
•

Slide the PCI board into the tray and push the PCI connector firmly into the slot.
Make sure it is completely seated (Figure 2-24).
You may need to use some pressure to seat it all the way.
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Figure 2-24

Installing the PCI Board on the R10000 Workstation

4. Insert and tighten the screw that secures the PCI board (Figure 2-25).

Figure 2-25

Securing the PCI Board

5. Go to “Reinstalling the System Module.”
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Removing a PCI Board: R10000 Workstation
1.

Remove the screw that secures the PCI board (Figure 2-26).

2. Slide the PCI board out of the tray. It may be a little difficult to remove.

Figure 2-26

Removing the Screw That Secures the PCI Board

3. If you are installing another PCI board, see “Installing a PCI Board: R10000
Workstation.” Otherwise, replace the screw and filler panel. (You removed the
screw and panel when you first installed the board.)
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Figure 2-27

Replacing the Filler Panel and Screw

4. Go to “Reinstalling the System Module.”

Installing a Digital Display Adapter Board
The figures in this section show an adapter board similar to the one that supports the
Presenter 1280 monitor and stereo view (Figure 2-28).
The board you are installing may look different, but the installation steps are the same.
See also any documentation that comes with the adapter board.
Caution: Option boards are extremely sensitive to static electricity. Handle it carefully,
and wear the wrist strap while installing the board.
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Figure 2-28

Identifying the Presenter 1280/Stereo VIew Board

The slot for the display adapter is on the system module.
1.

If you have not already done so, remove the power cable, and remove the system
module from the chassis. (See “Removing the System Module.”)

2. To remove the PCI tray:
•

If you have an R5000 workstation, go to “Removing the PCI Tray: R5000
Workstation.”

•

If you have an R10000 workstation, go to “Removing the PCI Tray: R10000
Workstation.”
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Removing the PCI Tray: R5000 Workstation
1.

Push up the lever on the side of the PCI tray to release it (Figure 2-29). The tray pops
up.

Figure 2-29

Releasing the PCI Tray

2. Push down slightly on the rear of the PCI tray and remove it from the system
module (Figure 2-30). Do not remove the PCI board from the tray, if one is installed.
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Figure 2-30

Removing the PCI Tray

3. Go to “Installing the Adapter Board.”

Removing the PCI Tray: R10000 Workstation
To remove the PCI tray in an R10000 workstation, you must first remove the plastic face
plate on the system module.
1.

Remove the plastic face plate of the system module as follows:
•

Use a Phillips screwdriver to remove five screws in the rear and two screws on
the underside, in the locations shown (Figure 2-31).
Caution: On the underside, remove only two screws. Do not remove the third
screw that attaches the lever to the face plate.
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Figure 2-31

•

Lift the face plate away from the module. The filler panel covering the I/O port
falls away as you remove the face plate.

Figure 2-32
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Removing the Screws From the Face Plate

Removing the Face Plate From the System Module

Installing a Digital Display Adapter Board

2. Remove the PCI tray from the system module. If a PCI board is installed in the tray, do
not remove it from the tray.
•

Insert a screwdriver in the small opening shown (Figure 2-33) and a prying or
twisting motion to release the PCI tray from the system module.

•

Pull the PCI tray straight up to remove it and set it aside.

Figure 2-33

Removing the PCI Tray From the R10000 System Module

3. Go to “Installing the Adapter Board.”

Installing the Adapter Board
Note: The illustrations show an R5000 workstation. The installation steps are the same

for an R10000 workstation.
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1.

Before touching any of the components, attach the wrist strap to your wrist and to
the metal part of the chassis (Figure 2-34).

Figure 2-34

Attaching the Wrist Strap

2. If there is a filler panel covering the I/O slot, remove it as follows:

52

•

Use a Phillips screwdriver to remove the two screws that hold it (Figure 2-35).

•

Push the filler panel inward.

•

Remove the filler panel and save it. In the event that you remove the digital
display adapter board and do not replace it, you must reinstall the panel.

Installing a Digital Display Adapter Board

Figure 2-35

Removing the I/O Filler Panel

3. To install the digital display adapter board, align the connector beneath the board
with the connector on the system board (Figure 2-36). Push the board firmly into the
socket until the connectors are completely seated.

Figure 2-36

Installing the Flat Panel/Stereo View Option Board
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4. Insert and tighten two screws in the locations shown (Figure 2-37).

Figure 2-37

Installing the Two Screws

5. Remove the wrist strap.
6. Reinstall the PCI tray.
•

R5000 workstations, go to “Reinstalling the PCI Tray: R5000 Workstation.”

•

R10000 workstation, go to “Reinstalling the PCI Tray: R10000 Workstation.”

Reinstalling the PCI Tray: R5000 Workstation
1.
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Reinstall the PCI tray in the system module (Figure 2-38).
•

Engage the hinge on the PCI tray in the slot.

•

Lower the tray and insert the connector into the slot, pushing toward the back
of the module as you do this.

Installing a Digital Display Adapter Board

Figure 2-38

Replacing the PCI Tray in the System Module

2. Push the tray down firmly until it is completely seated. Check that the lever returns
to its starting position (Figure 2-39).
Caution: If the PCI tray is not completely seated, the system module will not slide
back into the chassis.
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Figure 2-39

PCI Tray Seated Correctly

3. Go to “Reinstalling the System Module.”

Reinstalling the PCI Tray: R10000 Workstation
1.

Replace the PCI tray in the system module as follows:
•

Lower the PCI tray, engaging it on the tab on the side of the system module
(Figure 2-40).

•

Insert the PCI connector beneath the tray into the slot on the system module.

•

Once the connector is aligned, push down firmly until it is completely seated.

Note: If the PCI tray is not completely seated, the system module will not slide back

into the chassis.
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Figure 2-40

Replacing the R10000 PCI Tray in the System Module

2. Replace the face plate on the system module as follows:
•

Replace the filler panel over the I/O opening on the inside of the face plate.

•

Align the face plate on the system module (Figure 2-41).
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Figure 2-41

•

Use a Phillips screwdriver to insert and tighten two screws on the underside in
the locations shown (Figure 2-42).

Figure 2-42
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Replacing Two Screws on the Face Plate

Installing a Digital Display Adapter Board

•

Use a Phillips screwdriver to insert and tighten five screws on the rear in the
locations shown (Figure 2-43).

Figure 2-43

Replacing Five Screws on the Face Plate

3. Go to “Reinstalling the System Module.”

Removing a Digital Display Adapter Board
1.

If you have not already done so, remove the power cable, and remove the system
module from the chassis. (See “Removing the System Module.”)

2. To reach the digital display adapter board, you must first remove the PCI tray.
•

R5000 workstations, see “Removing the PCI Tray: R5000 Workstation.”

•

R10000 workstations, see “Removing the PCI Tray: R10000 Workstation.”

3. Before touching any of the components, attach the wrist strap to your wrist and to a
metal part of the chassis (Figure 2-28).
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Figure 2-44

Attaching the Wrist Strap

4. Grasp the board on either side and gently rock it out (Figure 2-45). Do not
exaggerate the rocking motion, or you will bend the pins.

Figure 2-45
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Reinstalling the System Module

5. If you are installing another display adapter option board, see “Installing the
Adapter Board.” Otherwise, replace the filler panel that you removed when you
installed the first display adapter board.
6. Remove the wrist strap.
7. To reinstall the PCI tray:
•

R5000 workstations, see “Reinstalling the PCI Tray: R5000 Workstation.”

•

R10000 workstations, see “Reinstalling the PCI Tray: R10000 Workstation.”

8. Go to “Reinstalling the System Module.”

Reinstalling the System Module
Note: The illustrations show an R5000 workstation. Installing the system module is the

same for an R10000 workstation.
1.

Return the system module to its upright position (Figure 2-46).

Figure 2-46

Returning the System Module to its Upright Position

2. Slide the system module into the chassis until the lever engages (Figure 2-47).
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Figure 2-47

Reinstalling the System Module in the Chassis

3. Push the lever up to lock the module in place (Figure 2-48).
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Figure 2-48

Securing the System Module in Place

4. Remove the wrist strap from the chassis.
5. Reconnect the power cable and any other cables you removed (Figure 2-49).
6. If you installed an option board that has a cable, connect the cable to the I/O port on
the board you installed.
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Figure 2-49

Connecting the Power Cable

7. Turn on the workstation by pressing the power button on the front (Figure 2-50).
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Turning On the Workstation

Verifying the Hardware Installation
Once you’ve installed memory or option boards, you should verify that the system
recognizes the new hardware.
1.

Log in to your account.

2. From the Toolchest, choose System > System Manager > About This System.

Figure 2-51

The Toolchest
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3. Look under the Hardware menu.
•

If you installed memory, check the amount of memory shown. It should equal
the total amount that you installed.
For example, if you had 32 MB of memory when you started and you installed
another 64 MB, the total shown should be 96 MB.
If the system does not show the total amount of memory you installed, turn off
the workstation, remove the power cable, remove the system module, and
make sure all the DIMMs are installed correctly. (See “Installing Memory
Modules.”). See also Chapter 4, “Troubleshooting.”

•
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If you installed a PCI option board, it will display. (For some option boards, the
software must be installed before the board is shown.) If it is not shown, turn off
the workstation, and go over the installation steps again to make sure the board
is seated correctly. (See “Installing a PCI Board: R5000 Workstation,” or
“Installing a PCI Board: R10000 Workstation.”)

Chapter 3

3. Installing or Removing Peripherals: Internal and
External Devices

This chapter tells you how to install or remove a second hard disk drive in your O2
workstation and how to connect external peripherals. The following topics are covered:
•

“Installing a Second Internal Hard Drive: R5000 Workstation”

•

“Removing the Second Internal Hard Disk Drive”

•

“Connecting External SCSI Devices”

•

“Connecting Parallel Devices (Floppy Drive and Printer)”

•

“Connecting Serial Devices”

•

“Connecting Audio and Video Devices”

Installing a Second Internal Hard Drive: R5000 Workstation
Note: The optional drive bay is not available on O2 R10000 workstations.
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1.

Turn off the workstation by pressing the power button on the front (Figure 3-1).
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Figure 3-1
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Turning Off the Workstation

2. Locate the optional drive bay (Figure 3-2). This is where you install the second
internal hard drive. The drive bay is covered with a blank panel that you must
remove.
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Figure 3-2

Locating the Optional Drive Bay

3. To remove the panel over the optional drive bay, you must first remove the
audio-visual module located on the far right as you face the rear of the workstation.
First, remove the power cable from the rear and any audio-visual cables that are
connected to the side panel (Figure 3-3).
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Figure 3-3

Disconnecting the Power Cable and Other Cables

4. Release the audio-visual module by pulling down the lever (Figure 3-4).
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Figure 3-4

Releasing the Audio-Visual Module

5. Slide the audio-visual module out of the chassis and place it carefully on a clean,
flat, antistatic surface, such as your desktop (Figure 3-5).
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Figure 3-5

Sliding Out the Audio-Visual Module

6. Press the button on the side of the optional drive bay to release the front panel
(Figure 3-6).
Save the panel. If you remove the second drive and do not replace it, you must
reinstall the panel.

72

Installing a Second Internal Hard Drive: R5000 Workstation

Figure 3-6

Removing the Panel From the Optional Drive bay

7. Slide the second hard drive you are installing into the optional drive bay until the
lever engages (Figure 3-7).
Note: There is no need to set the SCSI address on the second drive. The optional

drive bay on the O2 workstation is preconfigured.
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Figure 3-7

Installing the Second Hard Drive Module

8. Push the lever up to lock the drive module in place (Figure 3-8).
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Figure 3-8

Securing the Second Hard Drive Module

9. Slide the audio-visual module back into the bay on the far right of the chassis
(Figure 3-9).
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Figure 3-9

Reinstalling the Audio-Visual Module in the Chassis

10. Push the lever up to secure the audio-visual module in place (Figure 3-10).
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Figure 3-10

Securing the Audio-Visual Module

11. Reconnect the power cable to the rear of the workstation. Reconnect any audio and
video cables you removed from the side panel of the workstation (Figure 3-9).
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Figure 3-11

Connecting the Power Cable and Other Cables

12. Turn on the workstation by pressing the power button on the front (Figure 3-12).
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Turning on the Workstation

Verifying the Hardware Installation

To check that the system recognizes the new hard disk drive, from the Toolchest choose
System > System Manager > Hardware and Devices > Disk Manager. The system disk
and the second disk display.
For information on how to manage your disk space, see “Taking Advantage of a Second
Disk” in the Personal System Administration Guide.
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Removing the Second Internal Hard Disk Drive
1.

Turn off the workstation by pressing the power button on the front (Figure 3-13).
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Turning Off the Workstation

2. The second hard disk is in the optional drive bay—the one between the system
drive and the audio-visual module. Pull down the lever on the left side of the
optional drive module to release it (Figure 3-14).
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Figure 3-14

Releasing the Optional Drive Module

3. Pull the drive module out of the chassis (Figure 3-15).
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Figure 3-15

Sliding the Second Hard Drive Out of the Chassis

4. If you are installing another optional hard drive, see steps 7 and 8 of “Installing a
Second Internal Hard Drive: R5000 Workstation.” Otherwise, replace the blank filler
panel over the open drive slot (Figure 3-16). (You removed the panel when you first
installed the drive.)
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Figure 3-16

Replacing the Filler Panel

5. Reconnect the power cable to the rear of the workstation. Reconnect any
audio-visual cables you removed from the side or rear panel of the workstation.
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Figure 3-17

Reconnecting the Cables

Connecting External SCSI Devices
The following information is covered in this section:
•

“Choosing a SCSI Address for the External Device”

•

“Setting the SCSI Address on the External Device”

•

“Connecting One External SCSI Device”

•

“Connecting More Than One External Device”

•

“Where’s the Rest”

You can connect one or more external SCSI devices to the O2 workstation in a daisy chain
if the maximum combined cable length of all external SCSI cables does not exceed three
meters. You can connect either wide (68-pin) or narrow (58-pin) SCSI devices.
Each device has a unique SCSI address and is connected to the other devices in a chain,
with the first device connected to the SCSI port on the rear of the workstation. The last
device on the daisy chain must be terminated with an active SCSI terminator.
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Caution: For external SCSI devices to operate reliably, the maximum combined cable
length of all external SCSI cables cannot exceed three meters. Use the cable and active
SCSI terminator that came with the device. Using other types of cables or terminators can
result in data loss.
External SCSI devices include the following drives: 1/4" cartridge tape, digital audio
tape, digital linear tape, optical disk, removable cartridge disk, and hard disk. SCSI
scanners are also supported.

Choosing a SCSI Address for the External Device
Each device on the daisy chain needs a unique numeric SCSI address to distinguish it
from other devices. The O2 workstation has two built-in SCSI buses. The system drive,
the optional hard drive (if installed), and the internal CD-ROM drive are on the internal
SCSI bus. All external devices are on the external SCSI bus. You can connect up to fifteen
wide or seven narrow external devices, as long as the cable length limitation is not
exceeded.
If you have one or more external devices connected to your system, and you are adding
another device, check which addresses are assigned to the existing devices and then
choose another number. Follow these steps:
1.

From the Toolchest, choose System > System Manager > About This System.

2. Pick an unassigned number between 1 and 15 for the device you are adding.
If the SCSI devices and their addresses do not appear under “About This System,” type
hinv from a shell window.

Setting the SCSI Address on the External Device
Now you must set the address manually on the device you are installing. Most SCSI
devices have a pushbutton switch or dial. The switch or dial is usually located on the rear
or bottom of the device. You may need a small screwdriver or pen tip to set the dial or
push the buttons.
•

If you are installing the first external SCSI device, go to “Connecting One External
SCSI Device.”

•

If you are installing additional SCSI devices, go to “Connecting More Than One
External Device.”
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Connecting One External SCSI Device
1.

Turn off the workstation.
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Turning Off the Workstation

2. Choose the appropriate cable:
•

For a SCSI device with a wide, 68-pin connector, use a 68-pin SCSI-3 to 68-pin
SCSI-3 cable (0.75 meter).

•

For a SCSI device with a narrow, 50-pin connector, use a 68-pin SCSI-3 to 50-pin
Centronics SCSI-2 cable (0.75 meter).

3. Connect the SCSI cable to the SCSI port on the rear of the workstation and to the
SCSI connector on the back of the device. If there are thumbscrews on either side of
the connectors, tighten them (Figure 3-19).
Note: The illustration shows an R5000 workstation. Installing external SCSI devices

is the same on an R10000 workstation.
4. Connect the power cable to the SCSI device and to a working electrical outlet.
5. Connect the active SCSI terminator to the device.
6. Turn on the device, and then turn on workstation. It’s important that you do it in
this order, so that the workstation recognizes the device.
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Figure 3-19

Connecting One External Device to the Workstation

Where’s the Rest
You’ll find more information in “Setting Up Peripheral Connections” in the Personal
System Administration Guide.
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Connecting More Than One External Device
1.

Turn off the workstation.
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Figure 3-20

onG

raph

ics

Turning Off the Workstation

2. Remove the active SCSI terminator from the first device on the daisy chain.
Note: You can connect both wide (68-pin) and narrow (50-pin) SCSI devices to the

workstation, but keep in mind the following guidelines. If the first external device is
a 68-pin, you can daisychain a 50-pin device to it, but you cannot then daisychain a
68-pin to the 50-pin device. You can, however, have a 68-pin as the first device, a
68-pin as the second device, and a 50-pin as the third device.
Accepted configurations:
68-pin to 50-pin
68-pin to 68-pin to 50-pin
Incorrect configuration:
68-pin to 50-pin to 68-pin
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3. Choose the appropriate SCSI cable:
First external device:
•

SCSI device with a wide, 68-pin connector, use a 68-pin SCSI-3 to 68-pin SCSI-3
cable (0.75 meter).

•

SCSI device with a narrow, 50-pin connector, use a 68-pin SCSI-3 to 50-pin
Centronics SCSI-2 0 cable (0.75 meter).

Second and all other devices on the daisy chain:
•

SCSI device with a wide, 68-pin connector, use a 68-pin SCSI-3 to 68-pin SCSI-3
cable (0.25 meter).

•

SCSI device with a narrow, 50-pin connector, use a 50-pin Centronics SCSI-2 to
50-pin Centronics SCSI-2 cable
(.5 meter).

4. Link the devices in a daisychain (Figure 3-21).
First device: Connect the SCSI cable to the device and to the workstation. If there
are thumbscrews on either side of the connectors, tighten them.
Second and all other devices: Connect the SCSI cable to the connector on the back
of each device. If there are thumbscrews on either side of the connectors, tighten
them.
Note: The illustration shows an R5000 workstation. Installing external SCSI devices

is the same on an R10000 workstation.
5. Connect a power cable to each SCSI device and to a working electrical outlet.
6. Connect the active SCSI terminator to only the last device on the daisy chain.
7. Turn on each device, and then turn on workstation. It’s important that you do it in
this order, so that the workstation recognizes the devices.
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Figure 3-21

Connecting More than One Device in a Daisy Chain

Where’s the Rest
You’ll find more information in “Setting Up Peripheral Connections” in the Personal
System Administration Guide.

Connecting Parallel Devices (Floppy Drive and Printer)
Silicon Graphics offers an optional floppy drive that you connect to the parallel port on
the O2 workstation. The drive has an additional connector, to which you connect your
printer. The printer needs a Silicon Graphics O2 printer cable.
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If no floppy drive is connected to the workstation, connect your printer cable to the
parallel port on the workstation.
Follow these steps to connect the floppy drive (Figure 3-22).
Note: The illustration shows an R5000 workstation. Installing a floppy drive is the same

on an R10000 workstation.
1.

Connect either end of the cable that comes with the drive to the parallel port on the
workstation. Connect the other end to the connector on the rear of the drive, below
the workstation icon.

2. Connect your printer to the other connector on the rear of the drive (the one below
the printer icon), using a Silicon Graphics O2 printer cable.

Figure 3-22

Installing the Floppy Drive
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Connecting Serial Devices
Examples of serial devices you can connect to your O2 workstation include: dial and
button boxes, digitizer tablets, console terminals, modems, optical mice, MIDI (Musical
Instrument Digital Interface) devices, Spaceball™ and the Logitech Magellan 3D input
device.
Figure 3-23 shows the location of the serial ports on the rear of the workstation. The serial
ports are labeled 1 and 2 and are DB9 connectors. To view the serial port cable pinouts,
and for information on Silicon Graphics serial cables and converters, click Hardware
Central. (If your web browser is not loaded, it takes a few seconds to load.) Or, if you’re
viewing this on a remote server, see Appendix A, “Technical Specifications.”
Note: The illustration shows an R5000 workstation. Connecting serial devices is the

same on an R10000 workstation.

Serial ports

Figure 3-23
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Locating the Serial Ports

Connecting Audio and Video Devices

1.

Before connecting the device, use the Serial Device Manager to configure the serial
port you will use. From the Toolchest choose System > System Manager >
Hardware and Devices > Serial Devices Manager.

2. Connect one end of the serial cable to the serial port (Figure 3-23). Connect the other
end to the serial device. Note the following:
•

If you are connecting a console terminal, attach it to serial connector 1 only.

•

If you are connecting a dial and button box, you need to attach a
female-to-female adapter to the serial cable before connecting it to the
workstation.

•

If you’re connecting Macintosh® compatible MIDI (Musical Instrument Digital
Interface) equipment, you need the Silicon Graphics MIDI converter. To
purchase one, contact your Silicon Graphics service provider.

Connecting Audio and Video Devices
Figure 3-24 shows the location of the audio and video ports on the workstation.
Note: The illustration shows an R5000 workstation. Connecting audio and video devices

is the same on an R10000 workstation.
For cable pinout information, click Hardware Central. (If your web browser is not
loaded, it takes a few seconds to load.) Or, if you’re viewing this on a remote server, see
“Cable Pinout Assignments.”
For information on digital audio and video tools, see “About The Digital Media Tools
Guide”.

Audio Devices
The side panel audio ports support:
•

stereo line level in and out (RCA plugs)

•

stereo headphone out (3.5 mm phono)

•

mono microphone in (3.5 mm phono)
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The rear panel audio ports support:
•

stereo line out (3.5-mm phono)

•

embedded microphone in the O2Cam

Video Devices
Note: The video option is not available on all models.

Your workstation can send and receive analog composite (RCA) and s-video (MINIDIN)
signals. In addition, the digital camera port provides a digital video input and output
signal. The signal is Silicon Graphics proprietary and is similar to the parallel D-1 signal
used in professional video applications.
The analog s-video and analog composite video ports accept most consumer and
industrial grade video equipment.
Note: Connect the O2Cam before turning on the workstation, so that the system

recognizes the camera.
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Rear
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Stereo audio out

Audio

Headphones out

* Not all models

Figure 3-24

Audio and Video Ports
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Chapter 4

4. Troubleshooting

This chapter describes how to diagnose hardware problems. It also includes information
on running diagnostics. The following topics are covered:
•

“Diagnosing the Problem”

•

“Running Diagnostic Tests”

•

“Recovering from System Crash”

•

“Disabling the System Maintenance Password”

•

“Service and Support Information”

Diagnosing the Problem
If you suspect there is a problem with your hardware, use the flowchart (Figure 4-1) to
help isolate and solve the problem. To view the flowchart, resize the window by placing
the cursor on the border. When you see the resize cursor, drag the mouse to the size you
need. See also “Running Diagnostic Tests.”
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System Diagnostic Tests

There are three types of software diagnostics tests provided on the O2 workstation. Each
is described below:
•

“Power-On Tests”

•

“Confidence Tests”

•

“IDE Tests”

Power-On Tests
These run automatically on the major hardware components of the workstation each
time it is turned on. If the tests find a faulty part, the LED on the front of the system will
be red and there will probably be an error message. See also “Diagnosing the Problem.”
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Confidence Tests
There are confidence tests for the mouse, keyboard, monitor, audio subsystem, external
SCSI devices (excluding hard disks), Presenter, and ISDN connection.
To run the Confidence Tests, choose Toolchest > System > Confidence Tests. Double click
the icon for the part you believe is faulty, and follow the online instructions.

IDE Tests
The Interactive Diagnostic Environment (IDE) tests are more comprehensive than the
Confidence Tests, and take longer (as long as 30-45 minutes) to run. Follow these steps:
1.

Turn off the workstation, wait a few seconds, and then turn it on again.

2. When you see the System Startup notifier, click Stop for Maintenance, or press Esc.

Figure 4-4

System Startup Notifier

3. When you see the System Maintenance Menu, choose Run Diagnostics, or type 3
on the keyboard.
Tip: You can stop the tests at any time by pressing Esc.
Note: If you cannot reach the System Maintenance Menu, your system is faulty. If

you cannot run the diagnostics, you may have a faulty disk drive or other problem.
Contact your service provider.
4. At the end of the tests you see a message with the results of the tests. Press Enter
and then Esc to return to the System Maintenance Menu, from where you can
restart the system.

Recovering from System Crash
In most cases, your system will recover from a system crash automatically if you reboot
the system. If, however, you have lost data on your system disk, and you cannot
communicate with your system using the mouse or keyboard, or over the network,
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follow these instructions. The instructions assume you have a backup tape of your
system that has been made using the System Manager backup tool, or with the
/usr/sbin/Backup script. You also need a CD with your current IRIX operating system
level. If you are recovering data from a tape on a remote tape device, you need to know
the hostname, tape device name, and IP address of the remote system.
1.

Use a pen tip or an unwound paper clip to press the Reset button located on the
front panel (Figure 4-5).
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Pressing the Reset Button

2. When you see the System Startup notifier (Figure 4-6), click Stop for Maintenance or
press Esc.

Figure 4-6

System Startup Notifier

3. From the System Maintenance menu, choose Recover System, or type 4 on the
keyboard.
The System Recovery Menu appears (Figure 4-7).
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Figure 4-7

System Recovery Menu

4. If you have a CD-ROM drive connected to your system and the IRIX CD, click Local
CD-ROM. Then click Accept to start. Insert the CD when prompted. The system
takes five minutes or more to copy the information.
If you don’t have a CD-ROM drive, use a drive that is connected to another system
on the network. Click Remote Directory.
5. When a notifier appears asking you for the remote hostname, type the system’s
name, a colon (:), and the full pathname of the CD-ROM drive, followed by /dist.
For example, to access a CD-ROM drive on the system mars, you would type
mars:/CDROM/dist

After everything is copied from the CD to the system disk, you can restore your
data from a recent full backup tape. The backup must be one that has been made
using the System Manager backup tool, or with the /usr/sbin/Backup script.
Tip: If you need to check something on your system during the restore process, you

can get a shell prompt by typing sh at most question prompts.
6. If you have a local tape device, you see this message:
Restore will be from <tapename> OK? ([Y]es, [N]o): [Y]
tapename is the name of the local tape device.
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7. If you have a remote (network) tape device, when no tape device is found, or when
you answered “No” to the question in the previous step, you see this message:
Remote or local restore ([r]emote, [l]ocal):

•

If you answer “remote,” you have chosen to restore from the network, and you
must know the hostname, tape device name, and IP address of the
remote system. You also need to know the IP address of your
system. The IP address, such as 192.0.2.1, always has four components

separated by periods.
•

If you answer “local,” you have chosen a tape device that is connected to your
system, and you are prompted to enter the name of the tape device.

8. When you see the following message, remove the CD-ROM, insert your most recent
full backup tape, then press Enter.
Insert the first backup tape in the drive, then press <Enter>,
[q]uit (from recovery), [r]estart:

There is a pause while the program retrieves several files from the tape describing
the system state at the time the backup was made. Then you see this message:
Erase /x filesystem and make new one (y,n)? [n]

It prompts you for every filesystem that was known at the time of the backup.
Read the following to decide whether to answer y or n.
•

If you answer n for no, the system tries to salvage as many files as possible.
Then it uses your backup tape to replace the files it could not salvage. Usually
you should answer no, especially if your backup tape is not very recent. If the
file systems were badly damaged, or the backup was from a different level
operating system, you may need to answer yes.

•

If you answer y for yes, the system erases the filesystem and copies everything
from your backup tape to the disk. The system loses any information on that
filesystem that you created between now and when you made your backup
tape.

9. You see this message:
Starting recovery from tape.

After two or three minutes, the names of the files that the system is copying to the
disk start scrolling. When the recovery is complete, you see this message:
Recovery complete, restarting system.
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Note: If your backup tapes were old, or you were changing your operating system

level, you should reinstall the operating system from the IRIX CD that came with
your system after system recovery is complete. When you see the Startup System
notifier, press Esc, or click Stop for Maintenance. Then click Install System Software. For
more information on installing the operating system, see “Installing Software” in the
Personal System Administration Guide or the Appendix of the hardcopy O2 Workstation
Owner’s Guide.

Disabling the System Maintenance Password
If you are in the System Maintenance menu, and you choose Install System Software,
Run Diagnostics, Recover System, or Enter Command Monitor, you may be
prompted for a password.
If you do not know the password, you can disable it by installing a jumper (a small cap
that connects two pins) on the system board inside the workstation. The system board is
located in the system module. To install the jumper, you must first remove the system
module and the PCI tray. Follow these steps:
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1.

Turn off the workstation by pressing the power button on the front (Figure 4-8).
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Turning off the Workstation

2. Remove the system module by releasing the lever on the extreme left as you face the
rear of the workstation and sliding the module out. (See “Removing the System
Module.”)
3. Release and remove the PCI tray.
•

R5000 workstations, see “Removing a PCI Board: R5000 Workstation.”

•

R10000 workstations, see “Removing a PCI Board: R10000 Workstation.”

4. Before touching any of the components, attach the wrist strap to your wrist and to a
metal part of the chassis (Figure 4-9).
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Figure 4-9

Attaching the Wrist Strap

5. Remove the jumper from the system board in the location shown in Figure 4-10.
Note: You must remove the jumper if you choose to reset the PROM password.
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.

Jumper

Figure 4-10

Removing the Jumper

6. Reinstall the jumper in the location shown in Figure 4-11.
Note: The illustration shows an R5000 CPU. If you have an R10000 CPU, the pin location

on the system board is the same.
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Figure 4-11

Installing the Jumper

7. Remove the wrist strap.
8. Reinstall the PCI tray in the system module:
•

R5000 workstations, see “Reinstalling the PCI Tray: R5000 Workstation.”

•

R10000 workstations, see “Reinstalling the PCI Tray: R10000 Workstation.”

9. Reinstall the system module by sliding it into the chassis. See “Replacing the System
Module.”

Service and Support Information
Silicon Graphics provides a comprehensive product support and maintenance program
for its products. If you are in North America and would like support for your Silicon
Graphics supported products, contact the Technical Assistance Center at 1-800-800-4SGI
or your authorized service provider. If you are outside North America, contact the Silicon
Graphics subsidiary or authorized distributor in your country.
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5. Ordering, Removing, and Installing Replacement Parts

If you suspect there is a problem with your hardware, use the diagnostic flowchart in
“Diagnosing the Problem” on page 97 to help isolate the problem before calling your
local Silicon Graphics service provider.
The following topics are covered in this chapter:
•

“Ordering a Replacement Part”

•

“Replacing the System Module”

•

“Replacing the R5000 CPU Module”

•

“Replacing the R10000 CPU Module”

•

“Replacing the System Drive”

•

“Replacing the Audio-Visual Module”

•

“Replacing the Power Supply”

•

“Replacing the CD-ROM Drive”

•

“Replacing the Chassis”

Ordering a Replacement Part
1.

Before calling your local Silicon Graphics provider, have the following information
ready. You can record the information in the space provided in Table 5-1.
•

system serial number (see “Locating Your Workstation’s Serial Number”)

•

hardware configuration information including hardware upgrades, and IRIX
software version (choose Toolchest > System Manager)

•

description of the problem
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2. Use this space to record the information you need for your support call.
Table 5-1

Information Needed for Support Call

System Serial Number
Model Number
IRIX Version
Description of Problem

3. Remove the faulty part if instructed by your service provider to do so. See these
sections:
•

“Replacing the System Module”

•

“Replacing the R5000 CPU Module”

•

“Replacing the R10000 CPU Module”

•

“Replacing the System Drive”

•

“Replacing the Audio-Visual Module”

•

“Replacing the Power Supply”

•

“Replacing the CD-ROM Drive”

•

“Replacing the Chassis”

Replacing the System Module
If you are instructed by your service provider to replace the system module, follow these
steps.
Before replacing your system module, you must remove the memory modules, PCI tray,
CPU module, and digital display adapter board (if one is installed) from your existing
module and reinstall them on the replacement module you received.
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Note: It’s important that you remove the PCI tray, because the printed circuit board

beneath it contains a host chip with important information such as the workstation’s
serial number.
Follow these steps:
1.

Remove the power cable, and remove the system module from the chassis. See
“Removing the System Module” and “Reinstalling the System Module.”

2. Remove all of the DIMM modules from the system module you are returning and
reinstall them on the replacement system module. See “Removing Memory
Modules” and “Installing Memory Modules.”
3. Remove the PCI tray from the system module you are returning, and reinstall it on
the replacement system module. If a PCI board is installed in the tray, do not remove it
from the tray.
•

R5000 workstations, see “Removing a PCI Board: R5000 Workstation” and
“Installing a PCI Board: R5000 Workstation.”

•

R10000 workstations, see “Removing the PCI Tray: R10000 Workstation” and
“Installing a PCI Board: R10000 Workstation.”

4. Remove the CPU module from the system module you are returning, and reinstall it
on the replacement system module.
•

R5000 workstations, see “Replacing the R5000 CPU Module.”

•

R10000 workstations, see “Replacing the R10000 CPU Module.”

5. Remove the digital display adapter board, if one is installed, and reinstall it on the
replacement system module. See “Removing a Digital Display Adapter Board” and
“Installing a Digital Display Adapter Board.”
6. Ship the stripped-down system module back to Silicon Graphics in the container
that held the new system module.

Replacing the R5000 CPU Module
If you are instructed by your service provider to replace the R5000 CPU module, follow
these steps.
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1.

If you haven’t already done so, turn off the workstation, remove the power cable,
and remove the system module from the chassis. See “Removing the System
Module.”

2. Release the PCI tray by pushing up the lever on the side (Figure 5-1). The tray pops
up.

Figure 5-1

Releasing the PCI Tray on the R5000 Workstation

3. Push down slightly on the rear of the PCI tray and remove it from the system
module (Figure 5-2). Do not remove the PCI board (if one is installed) from the tray.
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Figure 5-2

Removing the PCI Tray

4. Before touching any of the components, ground yourself to a metal part of the
chassis. Attach the wrist strap to your wrist and to the metal flange (Figure 5-3).

Figure 5-3

Attaching the Wrist Strap
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5. Locate the R5000 CPU module (Figure 5-4). Use a Phillips screwdriver to remove the
two screws from the locations shown.

Figure 5-4

Removing the Phillips Screws on the R5000 CPU Module

6. Grasp the CPU module on both sides and gently rock it out (Figure 5-5). Do not
exaggerate the rocking motion, or you will bend the pins.
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Figure 5-5

Removing the R5000 CPU Module

7. Install the replacement R5000 CPU module (Figure 5-6).
•

Align the connector beneath the module with the connector on the system
board. Make sure it is positioned correctly before pressing down.

•

Press down gently on the CPU module until it is securely seated. You hear a
click as it connects.

•

Insert and tighten the two Phillips screws in the locations shown (Figure 5-6).
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Figure 5-6

Installing the Replacement CPU Module

8. Remove the wrist strap.
9. Reinstall the PCI tray in the system module (Figure 5-7).
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•

Engage the hinge on the PCI tray in the slot.

•

Lower the tray and insert the connector into the slot, pushing toward the back
of the module as you do this (Figure 5-7).

Replacing the R5000 CPU Module

Figure 5-7

Replacing the PCI Tray in the System Module

10. Push the tray down firmly until it is completely seated. Check that the lever returns
to its starting position (Figure 5-8).
Note: If the PCI tray is not completely seated, the system module will not slide back

into the chassis.
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Figure 5-8

PCI Tray Seated Correctly

11. Reinstall the system module, and reconnect the cables. See “Reinstalling the System
Module.”
12. Ship the old CPU module to Silicon Graphics in the container that held the
replacement CPU module.

Replacing the R10000 CPU Module
If you are instructed by your service provider to replace the R10000 CPU module, follow
these steps.
To remove the R10000 CPU module, you must first remove the plastic face plate of the
system module and the PCI tray.
1.

If you haven’t already done so, turn off the workstation, remove the power cable,
and remove the system module from the chassis. See “Removing the System
Module.”

2. Remove the plastic face plate from the system module:
•
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Use a Phillips screwdriver to remove five screws on the rear and two screws on
the underside, in the locations shown (Figure 5-9).

Replacing the R10000 CPU Module

Caution: On the underside, remove only two screws. Do not remove the third screw
that attaches the lever to the face plate.

Figure 5-9

Removing Seven Screws From the Face Plate

3. Lift the face plate away from the module (Figure 5-10).
There is a filler panel covering the I/O port which falls away as you remove the face
plate.
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Figure 5-10

Removing the Face Plate From the System Module

4. Release the PCI tray from the system module as follows. If a PCI board is installed in
the tray, do not remove it from the tray.
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•

Insert a screwdriver in the small opening shown in Figure 5-11 and use and a
prying or twisting motion to release the PCI connector from the system module.

•

Pull the PCI tray straight up to remove it and set it aside.

Replacing the R10000 CPU Module

Figure 5-11

Releasing the PCI tray From the System Module

5. Before touching any of the components, ground yourself to a metal part of the
chassis. Attach the wrist strap to your wrist and to a metal part of the chassis
(Figure 5-12).
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Figure 5-12

Attaching the Wrist Strap

6. Locate the R10000 CPU module. It is protected by a metal heat sink (Figure 5-13). Do
not remove the heat sink.
7. Use a Phillips screwdriver to remove four screws from the locations shown
(Figure 5-13).
Caution: Do not remove the four hex screws. Do not remove the two screws that
secure the fan.
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Figure 5-13

Removing the Screws From the R10000 CPU Module

8. Grasp the CPU module on both sides and gently rock it out (Figure 5-14). Do not
exaggerate the rocking motion, or you will bend the pins.
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Figure 5-14

Removing the R10000 CPU Module

9. Install the replacement R10000 CPU module (Figure 5-15).
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•

Align the screw holes on the CPU module with the screw holes on the CPU
support. Make sure it is positioned correctly before pressing down.

•

Press down gently on the CPU module until it is securely seated. You hear a
click as it connects.

•

Insert and tighten the four Phillips screws in the locations shown.

Replacing the R10000 CPU Module

Figure 5-15

Securing the R10000 CPU Module

10. Remove the wrist strap.
11. Replace the PCI tray in the system module as follows:
•

Lower the PCI tray, engaging it on the tab on the side of the system module
(Figure 5-16).

•

Insert the PCI connector beneath the tray into the slot on the system module.

•

Once the connector is aligned, push down firmly until it is completely seated.

Note: If the PCI tray is not completely seated, the system module will not slide back

into the chassis.
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Figure 5-16

Replacing the PCI Tray in the R10000 System Module

12. Replace the plastic face plate on the system module as follows.
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•

Replace the filler panel over the I/O opening on the inside of the face plate.

•

Align the face plate on the system module (Figure 5-17).

Replacing the R10000 CPU Module

Figure 5-17

•

Replacing the Face Plate

Use a Phillips screwdriver to insert and tighten two screws on the underside in
the locations shown (Figure 5-18).
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Figure 5-18

•

Use a Phillips screwdriver to insert and tighten five screws in the locations
shown (Figure 5-19).

Figure 5-19
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Replacing Two Screws on the Underside

Replacing Five Screws on the Face Plate

Replacing the System Drive

13. Go to “Reinstalling the System Module.”
14. Ship the original CPU module to Silicon Graphics in the container that held the
replacement CPU module.

Replacing the System Drive
If you are instructed by your service provider to replace the system drive, follow these
steps.
Before replacing the system drive, you must turn off the workstation, remove the power
cable and other exterior cables, and attach the wrist strap. Follow these steps:
1.

Turn off the workstation.

Silic

Figure 5-20
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Turning Off the Workstation

2. Remove the power cable from the rear.
Note: The illustrations show an R5000 workstation. Replacing the system drive is the

same on an R10000 workstation.
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Figure 5-21

Removing the Power Cables

3. Pull down the lever on the left side of the system drive module to release it
(Figure 5-22).
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Figure 5-22

Releasing the Drive Tray

4. Pull the system drive module out of the chassis (Figure 5-23).
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Figure 5-23

Removing the System Drive Module From the Chassis

5. Slide the replacement system drive module into the system drive bay (Figure 5-24).
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Replacing the System Drive

Figure 5-24

Installing the Replacement System Drive Module

6. Push the lever up to lock the tray in place (Figure 5-25).
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Figure 5-25

Securing the System Drive Module

7. Reconnect the power cable and turn on the workstation.
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Figure 5-26

Reconnecting the Power Cable

Replacing the Audio-Visual Module
If you are instructed by your service provider to replace the audio-visual module, follow
these steps.
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1.

Turn off the workstation.

o
Silic

Figure 5-27
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Turning Off the Workstation

2. Remove the power cable and any cables that are connected to the rear or side panel
of the audio-visual module (Figure 5-28).
Note: The illustrations show an R5000 workstation. Replacing the audio-visual

module is the same on an R10000 workstation.
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Figure 5-28

Removing the Cables From the Audio-Visual Module

3. Pull down the lever on the left side of the audio-visual module to release it
(Figure 5-29).
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Figure 5-29

Releasing the Audio-Visual Module

4. Pull the audio-visual module out of the chassis (Figure 5-30).
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Figure 5-30

Removing the Audio-Visual Module From the Chassis

5. Slide the replacement audio-visual module into the chassis (Figure 5-31).
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Figure 5-31

Installing the Replacement Audio-Visual Module

6. Push the lever up to lock the tray in place (Figure 5-32).
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Figure 5-32

Securing the Audio-Visual Module

7. Reconnect the power cable any audio-visual cables that you removed earlier
(Figure 5-33).
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Figure 5-33

Reconnecting the Audio -Visual Cables

8. Turn on the workstation (Figure 5-34).
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Figure 5-34
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Turning on the Workstation

Replacing the Power Supply
If you are instructed by your service provider to replace the power supply, follow these
steps.
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1.

Turn off the workstation (Figure 5-35).

Silic

Figure 5-35
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Turning Off the Workstation

2. Remove the power cable from the rear (Figure 5-36).
Note: The illustrations show an R5000 workstation. Replacing the power supply is

the same on an R10000 workstation.
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Figure 5-36

Removing the Power Cable

3. To release the bezel that covers the power supply, press the latch at the top of the
bezel (Figure 5-37). It swings out toward you. Remove it from the chassis.
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Figure 5-37

Removing the Bezel From the Power Supply

4. Slide the lever to the right to release the power supply (Figure 5-38).
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Replacing the Power Supply

Figure 5-38

Releasing the Power Supply

5. Grasp the pull ring and slide the power supply out of the chassis (Figure 5-39). Put
it aside.

147

Chapter 5: Ordering, Removing, and Installing Replacement Parts

Figure 5-39

Removing the Power Supply From the Chassis

6. Slide the new power supply in to the chassis, pushing it until it stops (Figure 5-40).
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Replacing the Power Supply

Figure 5-40

Installing the Replacement Power Supply

7. Push the lever to the left until it clicks (Figure 5-41).
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Figure 5-41

Locking the Power Supply in Place

8. Replace the bezel over the power supply. Place the tabs at the bottom of the bezel in
the slots on the chassis and snap it up into place (Figure 5-42).
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Replacing the Power Supply

Figure 5-42

Replacing the Bezel on the Power Supply

9. Reconnect the power cable and turn on the workstation.
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Figure 5-43

Reconnecting the Power Cable

Replacing the CD-ROM Drive
If you are instructed by your service provider to replace the CD-ROM drive, follow these
steps.
Replacing the CD-ROM drive involves several steps. You must first remove the exterior
covers before you can reach the drive. Follow these steps:
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1.

If the CD eject button does not work, insert a straightened paper clip in the tiny hole
beneath the eject button to release the CD-ROM tray (Figure 5-44). (The CD eject
button may not work if the CD-ROM has failed.)

Silic

Figure 5-44
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Opening the CD-ROM Drive

2. Remove the CD-ROM drive face plate as follows (Figure 5-45).
•

Hold the face plate between the thumb and forefinger of one hand while
bracing the tray with the other hand.

•

Push the face plate (but not the tray) upward with the thumb until it snaps
away from the tray.

•

Push the tray gently back into the drive until it is just inside the bezel. Do not
push it all the way. It will be easier for you later to extract the tray to reinstall
the face plate.
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Silic

Figure 5-45
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Removing the CD-ROM Drive Face Plate

3. Turn off the workstation and remove the power cable from the rear.
4. To release the bezel that covers the power supply, press the latch at the top of the
bezel. It swings out toward you (Figure 5-46). Remove it from the chassis.
Note: The illustrations show an R5000 workstation. Replacing the CD-ROM drive is

the same on an R10000 workstation.
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Figure 5-46

Removing the Power Supply Bezel

5. Remove the top cover of the CD-ROM drive as follows (Figure 5-47).
•

Look beneath the plastic cover for a release tab.

•

Press the tab toward the chassis and push the cover upward.
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Figure 5-47

Removing the Top Cover of the CD-ROM Drive

6. Use a Phillips screwdriver to remove the three screws that secure the outer cover
(Figure 5-48).
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Figure 5-48

Removing the Three Phillips Screws

7. Remove the outer cover by grasping the plastic cross-piece and lifting up the cover
(Figure 5-49).
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Figure 5-49

Removing the Outer Cover

8. Use a Phillips screwdriver to remove the two screws that secure the CD-ROM drive
(Figure 5-50).
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Figure 5-50

Removing the Screws From the CD-ROM Drive

9. Tilt the CD-ROM drive upward and unhinge it from the chassis. (Figure 5-51).
Caution: The CD-ROM drive has sharp metal edges. Be cautious when you handle
it.
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1

Figure 5-51

Removing the CD-ROM Drive

10. Disconnect the SCSI and power cables as follows (Figure 5-52).
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•

Remove the SCSI cable by pulling on the thin plastic tab attached to the cable.

•

Remove the four-wire power cable by pulling on the wing tabs on either side of
the connector. It may be tight, and you may need to wiggle it slightly as you
pull.

Replacing the CD-ROM Drive

Figure 5-52

Disconnecting the SCSI and Power Cables

11. Place the faulty CD-ROM drive aside.
12. Pick up the replacement CD-ROM drive.
•

Reconnect the SCSI cable and the four-wire power cable to the replacement
CD-ROM drive (Figure 5-53).

•

Press each connector in firmly.

•

Tuck the excess length of the SCSI cable with the terminator into the cavity
between the connector and the sheet metal.
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Figure 5-53

Reconnecting the SCSI and Power Cables

13. Install the replacement CD-ROM drive by sliding the two hinges on the drive’s
bezel into the slots on the chassis and lowering the drive until it is fully seated
(Figure 5-54). Make sure that you do not pinch the SCSI and power cables as you
lower the drive.
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Figure 5-54

Installing the Replacement CD-ROM Drive

14. Insert and tighten the two screws that secure the CD-ROM drive (Figure 5-55).
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Figure 5-55

Securing the CD-ROM Drive

15. Replace the outer cover by aligning the three screw holes on the cover with the
screw holes in the CD-ROM tray and lowering the cover until it is fully seated
(Figure 5-56).
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Figure 5-56

Replacing the Outer Cover

16. Insert and tighten the three screws that secure the outer cover (Figure 5-57).
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Figure 5-57

Securing the Outer Cover

17. Replace the top cover (Figure 5-58).
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•

Hold it at an angle and slide the tabs at the front end under the outer cover.

•

Lower it until the release tab snaps into place.

Replacing the CD-ROM Drive

Figure 5-58

Replacing the Top Cover of the CD-ROM Drive

18. Replace the plastic bezel over the power supply by inserting the hinges into the slots
beneath the power supply and pivoting the bezel up until it snaps into place
(Figure 5-59).
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Figure 5-59

Replacing the Power Supply Bezel

19. Replace the CD-ROM drive face plate as follows (Figure 5-60).
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•

Pull the tray out gently.

•

Align the guides on the sides of the face plate with the grooves on the sides of
the CD-ROM tray.

•

Push the face plate down while supporting the tray, until the release tabs lock.
Do not place too much downward pressure on the tray.

•

Push the tray back into the drive.

Replacing the CD-ROM Drive

Figure 5-60

Replacing the CD-ROM Face Plate

20. Reconnect the power cable and turn on the workstation.

Figure 5-61

Reconnecting the Power Cable
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Replacing the Chassis
If you are instructed by your service provider to replace the chassis, follow these steps.
Replacing the chassis consists of several steps. You must remove all of the removable
modules and reinstall them on the new chassis.
Caution: The chassis has sharp metal edges. Be cautious when you handle it.
1.

Turn off the workstation, remove the power cable, and remove the system module
from the chassis. See “Removing the System Module”. Reinstall the system module
on the replacement chassis. See “Reinstalling the System Module.”

2. Remove the system disk drive and reinstall it on the replacement chassis. See
“Replacing the System Drive.”
3. R5000 workstations: If an optional internal hard drive is installed, remove it and
reinstall it on the replacement chassis. See “Removing the Second Internal Hard
Disk Drive.”
4. Remove the audio-visual module and reinstall it on the replacement chassis. See
“Replacing the Audio-Visual Module.”
5. Remove the power supply and reinstall it on the replacement chassis. See
“Replacing the Power Supply.”
6. Remove the CD-ROM drive and reinstall it on the replacement chassis. See
“Replacing the CD-ROM Drive.”
7. Ship the stripped-down chassis shown in Figure 5-62 to Silicon Graphics.
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Figure 5-62

The Stripped Down Workstation Chassis

8. Reconnect the power cable and turn on the workstation.

Replacing the PCB on the PCI Tray
The system serial number is stored electronically (nvram) on the printed circuit board on
the PCI tray. If nvram is corrupted, you may be instructed by your service provider to
replace the PCI tray that contains the printed circuit board. Follow these steps:
1.

Turn off the workstation, remove the power cable, and remove the system module
from the chassis. See “Removing the System Module.”
Note: You can find illustrations for all the following steps in “Installing a PCI Board:

R5000 Workstation,” “Removing the PCI Tray: R5000 Workstation,” “Installing a PCI
Board: R10000 Workstation,” and “Replacing the R10000 CPU Module.”
2. Remove the PCI tray from the system module.
3. If a PCI board is installed in the tray, remove it. If not, remove the filler panel and
screw.
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4. Reinstall the PCI board into the new PCI tray. If no PCI board was installed, reinstall
the filler panel and screw.
5. Reinstall the PCI tray into the system module.
6. Reinstall the system module into the chassis. See “Reinstalling the System Module.”
7. Ship the PCI tray with the faulty PCB to Silicon Graphics in the container that
contained the new PCI tray.
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6. Safety and Regulatory Information

This chapter provides guidelines for adjusting your work surface to increase your
comfort and safety. It also contains environmental specifications and regulatory
statements. The following topics are covered.
•

“Human Factors Guidelines for Setting Up Your O2 Workstation”

•

“Regulatory Information”

Human Factors Guidelines for Setting Up Your O2 Workstation
You can increase the comfort and safety of your work environment, and decrease your
chances of repetitive strain injuries by following the guidelines given below. These
guidelines help you create a healthy and productive work environment.
To browse through additional information on setting up your workstation area, taking
frequent breaks, exercises you can do, and practicing safe work habits, click Hardware
Central. If your web browser is not loaded, it takes a few seconds to load. (This option is
not available if you’re viewing this on a remote server.)

ANSI Standard for Visual Display Terminal Workstations
Table 6-1 shows recommended guidelines for furniture and system adjustment, as
developed by the American National Standards Institute (ANSI).1
Local Visual Display Terminal (VDT) guidelines issued by country, state, or municipality
may apply and supercede the guidelines in Table 6-1.

1 American

National Standard for Human Factors Engineering of Visual Display Terminal Workstations.
ANSI/HFS 100-1988. Available through the Human Factors Society, Inc. P.O. Box 1369, Santa Monica
CA 90406, USA.
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Table 6-1

ANSI/HFS 100-1988 Guidelines for VDT Workplace Adjustment

Adjustment

Small Female cm (in)

Midpoint cm (in)

Large Male cm (in)

Seat pan height

40.6 (16.0)

46.3 (18.2)

52.0 (20.5)

Work surface height
(keyboard and
mouse)

58.5 (23.0)

64.75 (25.5)

71.0 (28.0)

Screen viewing
height

103.1 (40.6)

118.1 (46.5)

133.1 (52.4)

Screen viewing
distance

>30.5 (>12)

>30.5 (>12)

>30.5 (>12)

Screen viewing
angle

0-60 degrees

0-60 degrees

0-60 degrees

Adjustment parameters are defined in Figure 6-1. Guidelines are shown for small
females (standing height of 150 cm, or 59 in) and large males (standing height of 185 cm,
or 73 in). Midpoints are also interpolated for persons of more average height.
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Screen Viewing
Distance
Screen
Viewing
Angle
0º-60º

Screen
Viewing
Height

Work
Surface
Height

Figure 6-1

Seat
Pan
Height

Basic Parameters of Visual Display Terminal Workstation Adjustment (Adapted
From ANSI/HFS 100-1988)

CAD Operator Preferences
If you work on a CAD system, you may feel more comfortable using the ranges of
adjustment shown in Table 6-2.
Table 6-2

Workstation Adjustments Preferred by CAD Usersa

Adjustment cm (in)

Mean cm (in)

Range cm (in)

Seat pan height

54 (21.3)

50-57 (19.7-22.4)

Work surface height

73 (28.7)

70-80 (27.6 -31.5)

Monitor center above
floor

113 (44.5)

107-115 (42.1-45.3)

Screen viewing
distance

70 (27.6)

59-78 (23.2-30.7)
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Table 6-2 (continued)

Workstation Adjustments Preferred by CAD Usersa

Adjustment cm (in)

Mean cm (in)

Range cm (in)

Work surface tilt

8.6 degrees

2-13 degrees

Monitor tiltb

-7.7 degrees

-15 - +1 degrees

a. Derived from Grandjean, Etienne. Ergonomics in Computerized Offices. London: Taylor &
Francis Ltd., 1987, p. 148.
b. negative tilt = a forward monitor inclination (top of the screen toward the operator)

Regulatory Information
The following topics are covered in this section:
•

“Regulatory Information”

•

“Electromagnetic Emissions”

•

“Radio and Television Interference”

•

“Electrostatic Discharge”

•

“Shielded Cables”

Manufacturer’s Declaration of Conformity
Caution: This product has several governmental and third-party approvals, licenses,
and permits. Do not modify this product in any way that is not expressly approved by
Silicon Graphics. If you do, you may lose these approvals and your governmental agency
authority to operate this device.
The O2 workstation conforms to several national and international specifications and
European Directives listed on the Manufacturer’s Declaration of Conformity. The CE
mark insignia displayed on the device is an indication of conformity to the European
requirements.
A Manufacturer’s Declaration of Conformity is available on the World Wide Web. Look
on the system (regulatory) label on the rear or underneath your workstation to determine
your CMN (model) number. You need this number to identify the Declaration of
Conformity on the Web.
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To locate the information on the World Wide Web, enter the following in your browser
location window:
http://www.sgi.com/Products/compliance/index.html

Locate and print or save your Declaration of Conformity. Make a note of your CMN
number and the date of the Declaration of Conformity here for future reference.

Electromagnetic Emissions
This device complies with Part 15 of the FCC Rules. Operation is subject to the following
two conditions:
•

This device may not cause harmful interference.

•

This device must accept any interference received, including interference that may
cause undesired operation.

This digital device meets with Class B limits of the FCC rules and is intended for both
residential and business locations.
This Class B digital apparatus meets all requirements of the Canadian
Interference-Causing Equipment Regulations.
Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le
matériel brouilleur du Canada.
This device complies with Class B electromagnetic emissions limits of C.I.S.P.R.
Publication 22, Limits and Methods of Measurement of Radio Interference
Characteristics of Information Technology Equipment, Germany’s BZT Class B limits for
Information Technology Equipment, and with Japan’s VCCI Class 2 limits.
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Figure 6-2

VCCI Class 2 Statement for Japan

Radio and Television Interference
The equipment described in this guide generates and uses radio frequency energy. If it is
not installed and used in accordance with the instructions in this guide, it can cause radio
and television interference.
This equipment has been tested and complies with the limits for a Class B computing
device in accordance with the specifications in Part 15 of FCC rules. These specifications
are designed to provide reasonable protection against such interference in a residential
or office installation. However, there is no guarantee that the interference will not occur
in a particular installation.
You can determine whether your system is causing interference by turning it off. If the
interference stops, it was probably caused by the workstation or one of the peripherals.
To tell if the interference is caused by one of the peripherals, try disconnecting one
peripheral at a time to see if the interference stops. If it does, that peripheral is the cause
of the interference.
If your workstation does cause interference to radio or television reception, try to correct
the interference by using one or more of the following suggestions:
Turn the television or radio antenna until the interference stops.
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Move the workstation to one side or the other of the radio or television.
Move the system farther away from the radio or television.
Plug the system into an outlet that is on a different circuit from the radio or television.
(That is, make certain the workstation and the radio or television are on circuits
controlled by different circuit breakers or fuses.)

Electrostatic Discharge
Silicon Graphics designs and tests its products to be immune to effects of electrostatic
discharge (ESD). ESD is a source of electromagnetic interference and can cause problems
ranging from data errors and lockups to permanent component damage.
It is important that while you are operating your workstation you keep the top cover in
place. The shielded cables that came with the system and its peripherals should be
installed correctly, with all screws/thumbscrews fastened securely.
An ESD wrist strap is included with some products such as memory and graphics
upgrades. The wrist strap is used when installing these upgrades to prevent the
discharge of static electricity, and it should protect your system from ESD damage.

Shielded Cables
The O2 workstation is FCC-compliant under test conditions that include the use of
shielded cables between the workstation and its peripherals. Your O2 workstation and
any peripherals you purchase from Silicon Graphics have shielded cables. Shielded
cables reduce the possibility of interference with radio, television, and other devices. If
you use any cables that are not from Silicon Graphics, make sure they are shielded.
Telephone cables do not need to be shielded.
The monitor cable supplied with your system uses additional filtering molded into the
cable jacket to reduce radio frequency interference. Always use the cable supplied with
your system. If your monitor cable becomes damaged, a replacement cable should be
obtained from Silicon Graphics.
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Appendix A

A. Technical Specifications

To see this information in a web browser, click Hardware Central. (If your web browser
is not loaded, it takes a few seconds to load.) Or, if you are viewing this on a remote
system, see the sections below.
•

“Cable Pinout Assignments”

•

“Serial Cables and Converters”

•

“O2 Camera Technical Specifications”

•

“Physical Environment Specifications”

Cable Pinout Assignments
This section contains cable pinout information for the following O2 ports:
•

“Serial”

•

“Parallel”

•

“Ethernet 10-Base T/100-Base T”

•

“Keyboard and Mouse”

•

“SCSI”

•

“Audio”

•

“Composite Video (Analog) In and Out”

•

“S-Video (Analog) In and Out”

•

“Digital Video In and Out”

•

“Monitor”

•

“Stereo View”

•

“Presenter 1280 Flat Panel Adapter (Optional)”
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Serial
Table A-1 shows cable pinout assignments for the serial ports.
Serial Port Pinout Assignments

Table A-1
Pin

Assignment

Description

1

DCD

Data Carrier Detect

2

RD

Receive Data

3

TD

Transmit Data

4

DTR

Data Terminal Ready

5

SG

Signal Ground

6

DSR

Data Set Ready

7

RTS

Request to Send

8

CTS

Clear to Send

9

RI

Ring Indicator

Parallel
Table A-2 shows the cable pinout assignments for the IEEE 1284-C parallel port for
Silicon Graphics’ floppy drive or for a printer. (The floppy drive has an additional
connector for a printer.)
Table A-2
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Parallel Port (IEEE 1284-C) Pinout Assignments

Pin

Assignment

Pin

Assignment

1

BUSY

19

SIGNAL GROUND (BUSY)

2

SELECT

20

SIGNAL GROUND (SELECT)

3

nACK

21

SIGNAL GROUND (nACK)

4

nFAULT

22

SIGNAL GROUND (nFAULT)

5

pERROR

23

SIGNAL GROUND (pERROR)

Cable Pinout Assignments

Table A-2 (continued)

Parallel Port (IEEE 1284-C) Pinout Assignments

Pin

Assignment

Pin

Assignment

6

DATA 1

24

SIGNAL GROUND (DATA 1)

7

DATA 2

25

SIGNAL GROUND (DATA 2)

8

DATA 3

26

SIGNAL GROUND (DATA 3)

9

DATA 4

27

SIGNAL GROUND (DATA 4)

10

DATA 5

28

SIGNAL GROUND (DATA 5)

11

DATA 6

29

SIGNAL GROUND (DATA 6)

12

DATA 7

30

SIGNAL GROUND (DATA 7)

13

DATA 8

31

SIGNAL GROUND (DATA 8)

14

nINIT

32

SIGNAL GROUND (nINIT)

15

nSTROBE

33

SIGNAL GROUND (nSTROBE)

16

nSELECTIN

34

SIGNAL GROUND (nSELECTIN)

17

nAUTOFD

35

SIGNAL GROUND (nAUTOFD)

18

HOST LOGIC HIGH 36

PERIPHERAL LOGIC HIGH

Ethernet 10-Base T/100-Base T
Table A-3 shows the cable pinout assignments for the Ethernet 10-Base T/100-Base T
port.
Table A-3

Ethernet 10-BASE T/100-Base T Port Pinout Assignments

Pin

Assignment

1

TRANSMIT+

2

TRANSMIT–

3

RECEIVE+

4

(Reserved)

5

(Reserved)
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Table A-3 (continued)

Ethernet 10-BASE T/100-Base T Port Pinout Assignments

Pin

Assignment

6

RECEIVE–

7

(Reserved)

8

(Reserved)

Keyboard and Mouse
Table A-4 shows the cable pinout assignments for the keyboard and mouse ports.
Table A-4

Keyboard and Mouse Ports (6-pin MINIDIN) Pinout Assignments

Pin

Assignment

1

KEYBOARD/MOUSE DATA

2

(Reserved)

3

GROUND

4

KEYBOARD/MOUSE POWER (+5V)

5

KEYBOARD/MOUSE CLOCK

6

(Reserved)

SCSI
Table A-5 shows the cable pinout assignments for the SCSI port.
Table A-5
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SCSI Port Pinout Assignments

Pin

Assignment

Pin

Assignment

1

GROUND

35

-DB(12)

2

GROUND

36

-DB(13)

3

GROUND

37

-DB(14)

4

GROUND

38

-DB(15)

Cable Pinout Assignments

Table A-5 (continued)

SCSI Port Pinout Assignments

Pin

Assignment

Pin

Assignment

5

GROUND

39

-DB(P1)

6

GROUND

40

-DB(0)

7

GROUND

41

-DB(1)

8

GROUND

42

-DB(2)

9

GROUND

43

-DB(3)

10

GROUND

44

-DB(4)

11

GROUND

45

-DB(5)

12

GROUND

46

-DB(6)

13

GROUND

47

-DB(7)

14

GROUND

48

-DB(P)

15

GROUND

49

GROUND

16

GROUND

50

GROUND

17

TERMPWR

51

TERMPWR

18

TERMPWR

52

TERMPWR

19

OPEN

53

OPEN

20

GROUND

54

GROUND

21

GROUND

55

-ATN

22

GROUND

56

GROUND

23

GROUND

57

-BSY

24

GROUND

58

-ACK

25

GROUND

59

-RST

26

GROUND

60

-MSG

27

GROUND

61

-SEL

28

GROUND

62

-C/D
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Table A-5 (continued)

SCSI Port Pinout Assignments

Pin

Assignment

Pin

Assignment

29

GROUND

63

-REQ

30

GROUND

64

-I/O

31

GROUND

65

-DB(8)

32

GROUND

66

-DB(9)

33

GROUND

67

-DB(10)

34

GROUND

68

-DB(11)

Audio
Figure A-1 shows the cable pinout assignments for the audio ports.
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Cable Pinout Assignments

PORT

PLUG
Ground/return

Stereo line-level
audio LEFT IN/OUT
Signal
Ground/return
Stereo line-level
audio RIGHT IN/OUT
Signal
Ground/return
Stereo headphone
auxiliary
stereo line out 3.5mm
Right signal
Left signal
Ground/return
Mono microphone
in 3mm
Right signal
Left signal

Figure A-1

Audio Ports Pinout Assignments

Composite Video (Analog) In and Out
Table A-6 shows the cable pinout assignments for the analog composite video in and out
ports (RCA jack, NTSC or PAL formats)
Table A-6

Analog Composite Video Port(RCA, NTSC or PAL Formats) Pinout Assignments

Pin

Assignment

2 (sleeve)

GROUND

3 (tip)

DATA
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S-Video (Analog) In and Out
Figure A-2 shows the cable pinout assignments for the analog s-video in and out port.
(The video option is not available on all models).
Chromaingnd

Chromain

V12V
S-video IN

SDA
SCL

Lumaingnd

Chromaoutgnd

Lumain

Chromaout

S-video OUT

Lumaoutgnd

Figure A-2
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Lumaout

S-Video (Analog ) Port Pinout Assignments

Cable Pinout Assignments

Digital Video In and Out
Table A-7 shows the cable pinout assignments for the digital video in/out port for the
Silicon Graphics O2Cam digital video camera. (The video option is not available on all
models).
Table A-7

Digital Video Port for the O2Cam Camera

Pin

Assignment

Pin

Assignment

1

+5V

35

+5V

2

I2C_SCL

36

I2C_SDA

3

GPI IN

37

GPI OUTGND

4

GPI INGND

38

GPI OUT

5

OUTDATACLK

39

CAM MIC POS

6

OUTDATACLKGND 40

CAM MIC NEG

7

INDATA9GND

41

OUTDATA9

8

INDATA9

42

OUTDATA9GND

9

INDATA8GND

43

OUTDATA8

10

INDATA8

44

OUTDATA8GND

11

INDATA7GND

45

OUTDATA7

12

INDATA7

46

OUTDATA7GND

13

INDATA6GND

47

OUTDATA6

14

INDATA6

48

OUTDATA6GND

15

INDATA5GND

49

OUTDATA5

16

INDATA5

50

OUTDATA5GND

17

INDATA4GND

51

OUTDATA4

18

INDATA4

52

OUTDATA4GND

19

INDATA3GND

53

OUTDATA3

20

INDATA3

54

OUTDATA3GND
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Table A-7 (continued)

Digital Video Port for the O2Cam Camera

Pin

Assignment

Pin

Assignment

21

INDATA2GND

55

OUTDATA2

22

INDATA2

56

OUTDATA2GND

23

INDATA1GND

57

OUTDATA1

24

INDATA1

58

OUTDATA1GND

25

INDATA0GND

59

OUTDATA0

26

INDATA0

60

OUTDATA0GND

27

INDATACLK

61

RESERVED

28

INDATACLKGND

62

RESERVED

29

RESERVED

63

RESERVED

30

-12V

64

+12V

31

RESERVED

65

RESERVED

32

RESERVED

66

RESERVED

33

RESERVED

67

RESERVED

34

RESERVED

68

RESERVED

Monitor
Table A-8 shows the cable pinout assignments for the O2 monitor DSUB15 port.
Table A-8
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Monitor Port (DSUB15) Pinout Assignments

Pin

Assignment

1

RED

2

GREEN (complete sync in some modes)

3

BLUE

4

RESERVED

Cable Pinout Assignments

Table A-8 (continued)

Monitor Port (DSUB15) Pinout Assignments

Pin

Assignment

5

GROUND

6

RED RETURN

7

GREEN RETURN

8

BLUE RETURN

9

+5V, limited current

10

GROUND

11

RESERVED

12

IIC DATA

13

HORIZONTAL SYNC

14

VERTICAL SYNC

15

IIC CLOCK

Stereo View
Table A-9 shows the cable pinout assignments for the stereo view port on the optional
Presenter 1280/stereo view adapter board..
Table A-9

Optional Stereo View Port Pin Assignments

Pin

Assignment

1

STEREO POWER (+12V, 0.5A)

2

STEREO GROUND

3

VERTICAL - ODD FIELD

Presenter 1280 Flat Panel Adapter (Optional)
Table A-10 shows the cable pinout assignments for the optional Presenter 1280 adapter
board.
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Table A-10

Presenter 1280 Monitor Port (Optional)

Pin

Assignment

Pin

Assignment

1

RED_P[0]

35

RED_P[1]

2

RED_N[0]

36

RED_N[1]

3

RED_P[2]

37

RED_P[3]

4

RED_N[2]

38

RED_N[3]

5

RED_P[4]

39

RED_P[5]

6

RED_N[4]

40

RED_N[5]

7

RED_P[6]

41

RED_P[7]

8

RED_N[6]

42

RED_N[7]

9

GRN_P[0]

43

GRN_P[1]

10

GRN_N[0]

44

GRN_N[1]

11

GRN_P[2]

45

GRN_P[3]

12

GRN_N[2]

46

GRN_N[3]

13

GRN_P[4]

47

GRN_P[5]

14

GRN_N[4]

48

GRN_P[5]

15

GRN_P[6]

49

GRN_P[7]

16

GRN_N[6]

50

GRN_P[7]

17

BLUE_P[0]

51

BLUE_P[1]

18

BLUE_N[0]

52

BLUE_N[1]

19

BLUE_P[2]

53

BLUE_P[3]

20

BLUE_N[2]

54

BLUE_N[3]

21

BLUE_P[4]

55

BLUE_P[5]

22

BLUE_N[4]

56

BLUE_N[5]

23

BLUE_P[6]

57

BLUE_P[7]

Serial Cables and Converters

Table A-10 (continued)

Presenter 1280 Monitor Port (Optional)

Pin

Assignment

Pin

Assignment

24

BLUE_N[6]

58

BLUE_N[7]

25

FP_PIXEL_CLK_P

59

FP_HSYNC_CLK_P

26

FP_PIXEL_CLK_N

60

FP_HSYNC_CLK_N

27

FP_VSYNC_CLK_P

61

FP_AUDIO_R-P

28

FP_VSYNC_CLK_N

62

FP_AUDIO_R-N

29

POWERGOOD

63

FP_AUDIO_L-P

30

RESERVED

64

FP_AUDIO_L-N

31

CABLE_GND

65

CABLE_GND

32

CABLE_GND

66

CABLE_GND

33

FP_12C_DATA

67

FP_12C_CLK

34

CABLE_GND

68

CABLE_GND

Serial Cables and Converters
This section contains cable pinout information for serial cables that you can connect to
your O2 workstation. It also describes Silicon Graphics’ serial port converters. The
following topics are covered:
•

“Printer/Dumb Terminal Serial Cable”

•

“PC Modem Serial Cable”

•

“Serial Port Converters”

Printer/Dumb Terminal Serial Cable
For serial printers and dumb terminals, use a 3-wired standard PC cable. Table A-11
shows the cable connector pinout assignments for this cable.
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Note: For a 3-wire cable and no hardware flow control modem, you must use the

/dev/ttyd* command devices in the configuration files. For more detailed information, see
the serial man page. To access the man page, from the Toolchest choose Help > InfoSearch
and select “Man pages.” Or place the cursor in the console window and type
man serial
Table A-11
Signal
Description

Cable Pinout Assignments for the Printer/Dumb Terminal Serial Cable
Pin Number
DB9 Connector (Female)

Pin Number
DB-25 Connector (Male)

1

NOT CONNECTED

RXD

2

2

TXD

3

3

4

NOT CONNECTED

5

7

6

NOT CONNECTED

7

NOT CONNECTED

8

NOT CONNECTED

9

NOT CONNECTED

GND

PC Modem Serial Cable
Use a full-handshake (includes RTS and CTS) PC modem serial cable for a modem with
RTS/CTS flow control. Table A-12 shows the cable connector pin assignments for this
cable.
You can use this cable for all serial devices except those that do not need RTS flow control.
Devices like serial printers and dumb terminals that do not need RTS flow control can
still be used with this cable provided that a null modem adapter is added to one end of
the cable. You can purchase the full-handshake PC modem serial cable from Silicon
Graphics or your local service provider.
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Note: If you are attaching a modem with modem signals and RTS/CTS flow control, you

must use the /dev/ttyf* command devices in the configuration files. For more detailed
information, see the serial man page. To access this man page, from the Toolchest choose
Help > InfoSearch and select “Man pages.” Or place the cursor in the console window
and type
man serial
Table A-12

Cable Pinout Assignments for a PC Modem Cable

Signal
Description

Pin Number
DB9 Connector (Female)

Pin Number
DB-25 Connector (Male)

DCD

1

8

RXD

2

3

TXD

3

2

DTR

4

20

GND

5

7

DSR

6

6

RTS

7

4

CTS

8

5

RI

9

22

Serial Port Converters
The O2 workstation’s serial ports conform to the PC standard pinout for EIA standard
RS-232 signals. The transmit and receive circuits are also capable of higher speed
signalling according to the EIA RS-423 standard. In addition, you can convert these
signals to support other interfaces.
Silicon Graphics offers two converters: one for the RS-422, commonly used for video
deck control, and an Apple Macintosh® to MIDI converter for the RS-422-like signalling
used by MIDI devices to connect to Apple Macintosh serial ports.
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RS-422 Converter (DB-9 Female) For Video Deck Control

The Silicon Graphics RS-422 Converter takes the O2 workstation’s RS-232 Transmit Data
and Receive Data signals and converts them to SMPTE 207M-compatible RS-422 for
video deck control.
Table A-13 shows the pinouts for the O2 workstation end. Table A-14 shows the pinouts
for the video deck end.
Table A-13
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RS-422 Converter (DB-9 Female): Workstation End

Workstation Signal
Description

Pin Number

Voltage With Regard to
Ground Received From or
Supplied to Workstation

DCD

1

Passed through from
RS-422 spare

RXD

2

Supplies -5V typical low,
+5V typical high (RS-423)

TXD

3

0V maximum low, 1.6V
minimum high

DTR

4

Requires -12V maximum
low, +12 V minimum
high

SG

5

0

DSR

6

Not connected

RTS

7

Requires +12V to power
the converter

CTS

8

Not connected

RD

9

Not connected

Serial Cables and Converters

Table A-14

RS-422 Converter (DB-9 Female): Video Deck End

Video Deck End Signal
Description

Pin Number

Voltage
(Across Pair)

Frame GND

1

Not connected

Spare (Priority In)

5

Passed through to
workstation DCD

Controller Rcv A&B

2(-) and 7

Requires 0V maxmum
low, 1.6V minimum high

Controller Xmit A&B

8(-) and 3

Supplies 0V typical low,
+5V typical high

Signal GND

4, 6

0

Frame GND

9

Not connected

Macintosh to MIDI Converter (DB-9 Female to MiniDIN-8 Female)

The Silicon Graphics Macintosh to MIDI converter takes the O2 workstation’s RS-232
Transmit Data and Receive Data signals and converts them to RS-422-like signalling used
by MIDI devices to connect to Apple Macintosh serial ports.
Table A-15 shows the pinouts for the O2 workstation end. Table A-16 shows the pinouts
for the MIDI interface end.
Table A-15

Macintosh to MIDI Converter (DB-9 Female): Workstation End

Workstation Signal
Description

Pin Number

Voltage with Regard to
Ground Required From or
Supplied to Workstation

DCD

1

Passed through from GPi

RXD

2

Supplies 0V typical low,
+5V typical high

TXD

3

Requires 0V maximum
low, 1.6V minimum high
(RS-423)
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Table A-15

Workstation Signal
Description

Pin Number

Voltage with Regard to
Ground Required From or
Supplied to Workstation

DTR

4

Requires -12V maximum
low to +12V minimum
high

SG

5

0

DSR

6

Not connected

RTS

7

Requires +12V to power
the converter

CTS

8

Passed through from
handshake in

RD

9

Not connected

Table A-16
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Macintosh to MIDI Converter (DB-9 Female): Workstation End

Macintosh to MIDI Converter (MiniDIN-8 ): MIDI Interface End

Macintosh Signal
Description

Pin Number

Voltage With Regard to
Ground Supplied to or
Required From MIDI
Interface Unit

GPi

7

Passed through to DCD

RXD

5(-) and 8

Requires -0.2V maximum
low, 0.2V minimum high

TXD

32(-) and 6

Supplies -5V typical low,
+5V typical high

HANDSHAKE OUT

1

Supplies -5V typical low,
+5V typical high

SIGNAL GROUND

4

0

HANDSHAKE IN

2

Passed through to DCD

O2 Camera Technical Specifications

O2 Camera Technical Specifications
Table A-17 below lists O2Cam’s technical specifications.
Table A-17

O2Cam Technical Specificatons

Sensor

512 x 480 NTSC Color CCD, 1/3” format

Standard lens

F2.0, 6mm with M11 screw mount and built-in IR
filter.

Output format

Outputs 640 x 480 Square Pixel NTSC frames @
29.97Hz (780 x 525 total frame), as 422YCrCb pixels
with 1 byte luminance followed by 1 byte
chrominance, on a 24.5 MHz interface clock.

Automatic Gain
Control

Automatic Gain Control adjusts gain to achieve
average output brightness. AGC can be activated or
overridden (via new gain value) from workstation.

Shutter speeds

Selectable from 1/60 through 1/10,000 second

Auto white balance

Software initializes camera at workstation power on
and loads red and blue balance, red and blue
saturation, and gamma values that are balanced for
offices with or without windows, with incandescent
and/or fluorescent lights. User can make additional
white balance adjustments with the digital media
software.

Gamma correction

Gamma factor of 0 or 255 can be loaded into camera
by workstation at any time.

Push button

The control button drives the GPIBIN line on the
68-pin connector. While button is up, voltage is high;
while button is down, voltage is low.

Power requirements

1W @ 5V (200mA), 1W @ 12V (80mA), and 12 mW @
-12V (1mA) are provided by the workstation. These
are maximum amounts available to the camera,
actual consumption should be lower.

LED indicator

On/off state is controlled by the workstation via I2C.
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Table A-17 (continued)

O2Cam Technical Specificatons

Workstation interface DVCI uses 68-position 0.8 mm Champ connector on
far end of attached 8 ft cable. Video is transmitted at
TTL levels, 1 byte wide plus hsync and vsync. All
camera parameters are accessed and controlled by
the workstation via I2C. Workstation provides 5V
power.
Focus adjustment

Focal distance from 3” to infinity with standard lens.

Microphone

Built-in directional microphone and preamp
produces a monoaural, single-ended line level signal.

Physical Environment Specifications
Table A-18

Physical Environment Specifications for the O2 Workstation

Workstation’s dimensions

12"H x 9"W x 5"D

Power Requirements

100 - 132 VAC, 2.4 - 1.8A
200 - 264 VAC, 1.2 - 0.9 A
47 - 63 Hz
3-pin, earth grounded plug

200

Ambient Temperature

+10°C to 35°C (operating)
-40°C to +65°C (non-operating

Relative Humidity

10% to 80% operating (no condensation)
5% to 90% non-operating (no condensation)

Heat Dissipation

245 watts

Altitude

10,000’ (operating)
40,000 (non-operating)

Vibration

0.02" displacement, 5-19 Hz.
0.25 G, 5 - 500 Hz

Noise

35 dB (A) in typical operating position

Glossary

account
See login account.
active window
The only window that recognizes input (activity) from the keyboard and mouse; only
one window is active at a time.
address dial
See SCSI address dial.
administrator
The person who can use the most privileged account, root. This person must have a
personal login account for daily use, but when there are serious system problems to
correct, the person logs in to the root account to change system information using the
graphical tools or using the IRIX shell.
The Administrator has all the capabilities of a Privileged User, plus the capability to
change information in the root account (such as the password) and to log in to an IRIX
shell as root. Because there is only one root account, there is only one Administrator per
system. The Information Panel for a particular system includes the name of the system’s
Administrator so other users know whom to contact for help.
See network administrator.
back up
To copy a certain set of files and directories from your hard disk to a tape or other media.
backup tape
A tape that contains a copy of a set of files and directories that are on your hard disk. A
full backup tape contains a copy of all files and directories, including IRIX, that are on
your hard disk.
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Glossary

baud rate
A term used for the speed (calculated as bits per second) at which the computer sends
information to a serial device, such as a modem or terminal.
boot
To start up the system by turning on the workstation and monitor; the system is fully
booted when you see the console login prompt or the login screen.
button
On a mouse, a button is a switch that you press with a finger. In a window on your screen,
a button is a labelled rectangle that you click using the cursor and mouse.
CCIR 601
A high-end digital video interface standard developed by the CCIR (Comité Consultatif
International de Radiodiffusion, or International Radio Consultative Committee). In
CCIR 601 the luminance and chrominance are broken down into three digital signals: one
for luminance (brightness) and two for chrominance (color) information. The color
information is spatially subsampled horizontally so that the two chroma components
occupy the same data bandwidth as the luminance component. Both the luminance and
chrominance are then multiplexed up to a double rate byte wide data stream. The Silicon
Graphics digital standard used in the Moosehead workstation is very similar to 601, with
the exception that 601 is balanced ECL, while Silicon Graphics uses single-ended TTL.
Additionally, 601 requires a fixed number of samples per horizontal line, while the
Silicon Graphics implementation is programmable.
CD-ROM disk (CD)
A flat metallic disk that contains information that you can view and copy onto your own
hard disk; you cannot change or add to the information on the CD-ROM. CD-ROM is
short for compact disk: read-only memory.
centralized network
A network where a central server controls services and information; the server is
maintained by one or more individuals called network administrators. On a centralized
network that uses NIS, this server is called the NIS master, and all other systems on the
network are called NIS clients. See also network administrator, NIS, NIS client, NIS
domain, and NIS master.
chassis
The external metal framework of the workstation that contains its working parts.
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chrominance
In an image reproduction system, a separate signal that contains the color information.
Black, white, and all shades of gray have no chrominance and contain only the luminance
(brightness) portion of the signal. However, all colors have both chrominance and
luminance.
Chrominance is derived from the I and Q signals in the NTSC television system and the
U and V signals in the PAL television system. See also luminance.
click
To hold the mouse still, and then press and immediately release a mouse button.
composite video
A color encoding method or a video signal that contains all of the color, brightness, and
synchronizing information in one signal. The chief composite television standard signals
are NTSC, PAL, and SECAM. See also NTSC and PAL.
configuration file
A system file that you change to customize the way your system behaves. Such files are
sometimes referred to as customization files.
confidence test
A test that you run to make sure a particular device (such as the keyboard, mouse, or a
drive) is set up and working properly.
connector
Hardware at the end of a cable that lets you fasten the cable to an outlet, port, or another
connector.
console window
The window that appears as a stowed icon each time you log in; IRIX reports all status
and error messages to this window.
CPU module
The printed circuit board within your workstation chassis that contains the central
processing unit.
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current working directory
The directory within the filesystem in which you are currently located when you are
working in a shell window.
cursor
The small red arrow on the screen that echoes the movements of the mouse. It changes
shape depending on its location on the screen.
DAT (Digital Audio Tape)
A magnetic tape from which you can read and to which you can copy audio and digital
information.
default printer
The printer to which the system directs a print request if you do not specify a printer
when you make the request. You set the default printer using the Print Manager.
default subsystems
Portions of a product that are installed automatically if you do not customize a product
installation.
defaults
A set of behaviors that Silicon Graphics specifies on every system. You can later change
these specifications, which range from how your screen looks to what type of drive you
want to use to install new software.
diagnostics
A series of tests that check all hardware components of your system.
DIMM (double inline memory module)
A small printed circuit board with several chips that contain additional megabytes of
random-access memory (RAM).
DIMM socket
A long, thin, female connector located on the system board into which you insert a
DIMM.
directory
A container in the filesystem in which you store other directories and files.
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disk resource
Any disk (hard, CD-ROM, floppy, or floptical) that you can access either because it is
physically attached to your workstation with a cable, or because it is available over the
network using NFS. See also NFS.
disk use
The percentage of space on your disk that contains information.
double-click
To hold the mouse still, then press and release it twice, very rapidly. When you
double-click an icon it opens into a window; when you double-click the Window menu
button the window closes.
drag
To press and hold down a mouse button, then move the mouse. This drags the cursor to
move icons or to highlight menu items.
drive
A hardware device that lets you access information on various forms of media, such as
hard, floppy, and CD-ROM discs, and magnetic tapes.
drive address
See SCSI address.
external device
Any piece of hardware that is attached to the workstation with a cable.
export
To use NFS software to make all or part of your filesystem available to other users and
systems on the network.
female connector
A connector that has indentations or holes into which you plug a male connector. An
example of a female connector is an electrical wall outlet that accepts an electrical plug.
field
An area in a window in which you can type text.
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file
A container in which you store information such as text, programs, or images you create
using an application.
filesystem
A hierarchy of directories and files. Directories contain other directories and files; files
cannot contain directories. The root (/) directory is at the top of the hierarchy.
form
A window that contains buttons that you must click and/or editable fields that you must
fill in.
grounded electrical outlet
An electrical wall outlet that accepts a plug that has a grounding prong. In the USA, all
three-prong outlets are grounded.
handshake
The protocol that controls the flow of information between a workstation and a printer
or any other peripheral. A hardware handshake uses only cable wires and pins to control
the flow. A software handshake (also called xon-xoff flow control) uses a combination of
pins, wires, and software.
highlight
To change the color of an item on the screen by positioning the cursor over it
(locate-highlight) or by positioning the cursor over it and pressing a mouse button.
home directory
The directory into which IRIX places you each time you log in. It is specified in your login
account; you own this directory and, typically, all its contents.
host
Any system connected to the network.
hostname
The name that uniquely identifies each host (system) on the network.
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human factors guidelines
A set of standards and suggestions for making your working environment more
comfortable and healthy.
icon
A small picture that represents a stowed or closed file, directory, application, or IRIX
process.
internal drive
A drive that fits inside the workstation and connects to an internal port; it is never
connected with a cable to a visible external port. An internal drive is occasionally referred
to as a front-loading drive.
IP address
The Internet Protocol number that uniquely identifies each host (system) on the network.
192.0.2.1 is an example of an IP address. It always has four components, separated by
periods.
IRIX
Silicon Graphics’s version of the UNIX operating system. See also system software.
ISDN (integrated services digital network)
A combination of software, hardware, and telephone services that let you communicate
with other systems and networks over a high-speed telephone line just as you
communicate with other systems and networks over an Ethernet cable.
jot
The text editor that comes as a standard utility on Silicon Graphics workstations.
KB (kilobyte)
A standard unit for measuring the information storage capacity of disks and memory
(RAM and ROM); 1024 bytes make one kilobyte.
LED (light emitting diode)
A light on a piece of hardware that indicates status or error conditions.
launch
To start up an application, often by double-clicking an icon.
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local workstation, drive, disk, filesystem, or printer
The physical workstation whose keyboard and mouse you are using, all hardware that is
connected to that workstation, and all software that resides on that hardware or its
removable media.
log in
To give the system your login name so you can start a session on the workstation.
log out
To end a session on the workstation.
login account
A database of information about each user that, at the minimum, consists of login name,
user ID, and a home directory.
login name
A name that uniquely identifies a user to the system.
login screen
The window that you see after powering on the system, before you can access files and
directories. The window can contain one icon for each login account on the system.
luminance
The perceived brightness of a surface. Typically refers to a weighted average of red,
green, and blue color values that gives the perceived brightness of the combination. For
video systems, luminance is the video signal that describes the amount of light in each
pixel. See also chrominance.
MB (megabyte)
A standard unit for measuring the information storage capacity of disks and memory
(RAM and ROM); 1024 kilobytes make one megabyte.
male connector
A connector that has raised edges, pins, or other protruding parts that you plug into a
female connector. An example of a male connector is an electrical plug that you plug into
a wall outlet.
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man page
An online document that describes how to use a particular IRIX command.
menu
A list of operations or commands that the workstation can carry out on various objects
on the screen.
MIDI (Musical Instrument Digital Interface)
On the Moosehead workstation, a MIDI devices (such as a keyboard) can be connected
to the serial ports.
monitor
A hardware device that displays the images, windows, and text with which you interact
to use the system. It is also called a video display terminal (VDT).
monitor video cable
The cable that connects the monitor to the workstation to transmit video signals. It is
thick and beige, with large connectors on both ends.
monitor power cable
The cable that connects the monitor to the workstation to provide power to the monitor.
It is thick and beige, with a male connector on one end and a female connector on the
other.
mount point
The directory on your workstation from which you access information that is stored on
a local or remote disk resource.
mount
To make a filesystem that is stored on a local or remote disk resource accessible from a
specific directory on your workstation.
mouse
A hardware device you use to communicate with windows and icons. You move the
mouse to move the cursor on the screen, and you press its buttons to initiate operations.
An optical mouse must always be on the mouse pad for the IRIS system to interpret its
movements; a mechanical mouse works on any clean, flat surface.
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mouse pad
For an optical mouse, this is the rectangular, metallic surface that “reads” the movements
of the mouse. For a mechanical mouse, this is a clean, soft rectangular surface that makes
the mouse’s track ball roll efficiently.
network
A group of computers and other devices (such as printers) that can all communicate with
each other electronically to transfer and share information.
network administrator
The individual(s) responsible for setting up, maintaining, and troubleshooting the
network, and for supplying setup information to system administrators of each system.
NFS® (Network File System)
A networking software option that lets you access files and directories that reside on the
disks of other workstations as if they resided on a local disk in your own workstation.
notifier
A form that appears when the system requires you to confirm an operation that you just
requested, or when an error occurs.
NTSC
A color television standard or timing format encoding all of the color, brightness, and
synchronizing information in one signal. Used in North America, most of South
America, and most of the Far East, this standard is named after the National Television
Systems Committee, the standardizing body that created the system in the United States
in 1953. NTSC uses a total of 525 horizontal lines per frame, with two fields per frame of
262.5 lines each. Each field refreshes at 60 Hz (actually 59.94 Hz).
open
To double-click an icon, or to select an icon, then choose “Open” from a menu in order to
display a window that contains the information that the icon represents.
option drive
Any internal drive other than the system disk. Option drives include floppy disk drives,
floptical disk drives, secondary hard disk drives, or DAT drives.
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outlets
Openings in the hardware to which you attach connectors to make an electrical
connection.
PAL
Stands for Phase Alternation Line or Phase Alternated by Line, by which the workstation
attempts to correct some of the color inaccuracies in NTSC. PAL is a color television
standard or timing format developed in West Germany and used by most other countries
in Europe (including the United Kingdom but excluding France), as well as Australia and
parts of the Far East. PAL uses a total of 625 horizontal lines per frame, with two fields
per frame of 312.5 lines per field. Each field refreshes at 50 Hz. PAL color encoding is
different from NTSC encoding. See also NTSC.
PCI
Stands for Peripheral Component Interconnect—a bus specification. The PCI bus is a
high-performance local bus used to connect peripherals to memory and a
microprocessor. A wide range of vendors make devices that plug into the PCI bus.
PROM monitor
The interface that you use to communicate with the system after it is powered on, but
before it is booted and running IRIX.
Printer Manager
A tool that you access through the System Manager. You use it to set up printer software
and monitor jobs that you send to the printer.
parallel device
Any hardware device that requires a parallel cable connection to communicate with the
workstation. A parallel interface transfers bits of information down a number of wires
simultaneously.
parallel port
An outlet on the workstation to which you connect external parallel devices. A parallel
interface transfers bits of information down a number of wires simultaneously.
password
A combination of letters and/or numbers that only you know; it is an optional element
of your login account. If you specify a password for your account, you must type it after
you type your login name before the system lets you access files and directories.
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pathname
The list of directories that leads you from the root (/) directory to a specific file or
directory in the filesystem.
peripheral
A hardware device that adds more functionality to the basic workstation, such as a tape
drive. See also external devices and internal drives.
port
An outlet on the workstation to which you attach cable connectors.
power-on diagnostics
A series of tests that automatically check hardware components of your system each time
you turn it on.
power cable
The cable that connects the workstation to a grounded electrical outlet.
power off
To turn off the power switches on the workstation chassis and the monitor.
power supply
The piece of hardware within the chassis that directs power from an electrical outlet to
the chassis, the monitor, and internal SCSI devices. It also contains the power switch,
reset button, and fan.
power on
To turn on the power switches on the workstation chassis and the monitor.
prompt
A character or word that the system displays in an IRIX shell. Indicates that the system
is ready to accept commands. The default prompt for regular user accounts is %; the
default prompt for the root account is #.
quit
To stop running an application.
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remote workstation, drive, disk, filesystem, or printer
A hardware device or the information or media it contains that you can access across the
network; it is not physically connected to your workstation.
reset button
A physical button on the workstation that you press to cut off then immediately restore
power to the workstation. You should never press this button while IRIX is running,
unless all attempts to shut down the system using software fail. See also shut down.
restore (files)
To copy files that once resided on your hard disk from another disk or a tape back onto
your hard disk.
root account
The standard IRIX login account reserved for use by the system administrator. This
account’s home directory is the root (/) directory of the filesystem; the user of the root
account has full access to the entire filesystem (that is, can change and delete any file or
directory). The user of this account is sometimes referred to as the superuser.
root (/) directory
The directory at the top of the file system hierarchy.
SCSI (small computer system interface)
Pronounced “scuzzy.” SCSI is a high-speed input/output specification for small
computers.
SCSI address
A number from one to seven that uniquely identifies a SCSI device to a system. No two
SCSI devices that are physically connected to the same workstation can have the same
SCSI address.
SCSI address dial
A small plastic dial connected to most external SCSI devices supplied by Silicon
Graphics. You click on its small buttons to select a SCSI address for a new SCSI device.
SCSI bus line
The combined length of all internal and external SCSI cables in a system.
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SCSI cable
A cable that connects a SCSI device to a SCSI port on a workstation.
SCSI device
A hardware device that uses the Small Computer System Interface (SCSI) protocol to
communicate with the system. Hard disk, floppy disk, floptical disk, CD-ROM, and tape
drives are all SCSI devices.
SCSI terminator
A metal cap that you plug into any open SCSI port on a SCSI bus line. No SCSI devices
on a SCSI bus line will work unless all SCSI ports are occupied by either a cable or
terminator.
screen
The portion of the monitor that displays information.
select
To position the cursor over an icon then click the (left) mouse button. Once an icon is
selected, it is the object of whatever operation you select from a menu.
serial device
Any hardware device that requires a serial cable connection to communicate with the
workstation.
serial port
An outlet on the workstation to which you connect external serial devices.
server
A system that other systems on the network access to use its disk space, software, or
services.
shell
A window into which you type IRIX commands.
shielded cable
A cable with a protective covering that reduces the possibility of interference with radio,
television, and other devices.

214

Glossary

shut down
To safely close all files, log out, and bring the workstation to a state where you can safely
power it off. Choose “System Shutdown” from the System toolchest menu to do this.
software option
Any software product that you buy from Silicon Graphics other than the standard system
software that comes on your system disk.
standalone workstation
A workstation that is not connected to a network.
static electricity
Whenever your body comes in physical contact with metal parts (including printed
circuit boards) of computer equipment there is the potential for you to feel an electrical
shock (electro-static discharge or ESD) which could damage the equipment. To prevent
this, you must always wear a wrist strap when working with internal parts of a
workstation.
subsystem
A portion of a software product. Each product consists of several subsystems; some are
required and some are optional.
superuser
An alternate name for the user of the root login account. See also system administrator.
s-video
An increasingly popular analog video signal format that achieves higher picture quality
than composite video by passing the luminance (brightness) and chrominance (color)
information on separate wires.
system
All the hardware and software that make up the workstation.
system administration
The tasks associated with setting up, maintaining, and troubleshooting a networked or
standalone system.
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system crash
When the IRIX operating system fails and the system will not accept any keyboard or
mouse input.
system disk
The physical disk that contains the standard IRIX operating system software—the
software that makes your workstation run.
System Manager
A set of tools that the administrator uses to set up and manage the workstation. You
access the System Manager through the System menu in the Toolchest.
system software
The standard IRIX operating system software and Silicon Graphics tools that come on the
system disk and on the tape or CD-ROM that you use in the event of a system crash.
TCP/IP
Stands for Transmission Control Protocol/Internet Protocol. A set of networking
protocols for wide area networks (WANs). It is also gaining popularity on local area
networks (LANs).
thumbscrew
The ridged knob attached to a screw in a cable connector that you turn to secure the
connector to an outlet.
Toolchest
The menus in the upper left-hand corner of the desktop. You start system tools such as
the System Manager and Software Manager using its menus.
upgrade (hardware)
Hardware that you add to the basic workstation that increases performance, such as
additional memory and option boards.
unmount
To make a filesystem that is accessible from a specific directory on your workstation
temporarily unaccessible.
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user ID
A number that uniquely identifies a user to the system.
window
A portion of the screen that you can manipulate that contains text or graphics.
workstation
The physical hardware that contains the CPU and graphics boards, a system disk, and a
power supply. You connect it to a monitor, keyboard, and mouse to configure a working
system. It is also sometimes referred to as the chassis.
wrist strap
A band with a loop for your wrist at one end and copper foil at the other. You attach the
end with the foil to a metal part of the workstation and place the loop around your wrist.
You use the strap whenever you work with internal components of the workstation to
avoid electrical shocks to yourself and the components. See also static electricity.
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